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Introduction to TopSolid 7 

The purpose of this first section of the guide is to familiarize yourself with the TopSolid 7 environment and some 
of the tools available. 

For your information, TopSolid 7 is a certified Gold Level partner of Microsoft and is fully compatible with 
Windows 10. 

TopSolid 7 environment 

Start page 

 

1 Creation of new documents 

2 Recent/Pinned documents (favorites) 

3 Recent/Pinned projects (favorites) 

4 Shortcut access to the online help, TopSolid'Design tutorial, TopSolid'Forum, 
etc. 
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General user interface 

 

1 TopSolid 7 button 13 Dialog area 

2 System toolbar 14 Default attributes 

3 Context and menu tabs 15 Compass 

4 Dialog box 16 Graphics area 

5 Document tabs 17 Visualization and rendering bar 

6 Context commands (control bar) 18 Scale bar 

7 Banner 19 Project tree 

8 Context states 20 Project tabs 

9 Entities tree 21 Preview area 

10 Operations tree 22 Visualization tolerance 

11 Parts tree 23 Tree toolbar 

12 Options tree   
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Context tabs 

The tabs change depending on the type of document you are using and define the commands available in the 
control bar. 

Example for a part document: 

 

Example for an assembly document: 

 

Example for a drafting document: 

 

Control bar 

The control bar includes the various TopSolid commands and changes depending on the active context tab. 

Example for the sketch: 

 
 
There are four ways to launch a command: 

- via the control bar; 

 

- via the drop-down menu of a context tab; 

 

- via the contextual menu by right-clicking in the graphics area or on an entity; 

 

- via the keyboard shortcut that you have previously defined in the Tools >  Customize > Shortcut keys 
tab. 
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The main trees 

The trees are scalable dialog boxes (size, position, on one or more screens, etc.) that contain all the information 
required to design and manage a project. They change depending on the type of document you are using. 

 

The main trees are the following: 

Project Operations Entities 

Contains all the project's 
documents (parts, assemblies, 

drawings, etc.). 

Contains all the operations created 
in the active document. 

Contains all the entities created in 
the active document (sketches, 

points, planes, parameters, etc.). 

   

 

Parts Searches 

Contains all the parts and sub-
assemblies of an assembly 

document. 

Contains all the defined searches. 
The searches allow you to quickly 
access documents according to a 

variety of criteria (material, name, 
property, type, etc.). 
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The main types of documents 

Part Assembly Drafting 

Contains the part definition 
(properties, materials, geometries, 

operations). 

Allows you to assemble several 
parts, create extruded bars, etc. 

Allows you to project, dimension, 
annotate, etc. parts and 

assemblies.  
This step usually ends a study. 

   

Bill of Materials Unfolding Family 

Lists all the parts/sub-assemblies of 
an assembly. This list is fully 

customizable (filters, columns, 
level of detail, etc.) 

Contains the unfolding of a part. 
This document can be directly 

exported or nested. 

Allows you to make a part 
parametric, an assembly or a 2D 

symbol in order to be used in 
different declinations. 

   

Work 

Allows you to automate the 
creation of documents. 
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Use of the mouse 

       Selection of item, icon, command, etc. 

    Editing an operation 

       Contextual menu of an item 

        Validation of a command 

       Zoom in/out on mouse cursor 

        Global zoom on the displayed entities  

     + movement   Dynamic rotation 

      + movement   Dynamic translation (planar movement of the graphics area) 

       In the graphics area: Rectangular selection of items or drag and drop items 

       On a document's tab: Close document 

     On the  icon of a context tab or  on a context tab: Drop-down menu of the context tab 
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Visualization 

 
 

 
  

Pan 

Rotation 

Top camera and access to other cameras (bottom, front, 
etc.) 

Global zoom 

View management 

Render management 

Default attributes 

Default line styles 

Perspective view 

Zoom 

Spin 
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Keyboard shortcuts 

TopSolid 7 uses a large number of keyboard shortcuts - most of them basic Windows shortcuts. You do not need to 
know them by heart necessarily, but they can help save you time in your everyday work. Here is a non-exhaustive 
list of the most frequently used keyboard shortcuts. 

Keyboard shortcut Action 

Ctrl + C Copy the selected item 

Ctrl + V Paste the selected item 

Ctrl + X Cut the selected item 

Ctrl + Z Undo an action 

Ctrl + Y Redo an action 

Ctrl + A Select all items in a document or dialog box 

Ctrl + left mouse click Select several items or remove items from a selection 

Ctrl + S Save the active document 

Ctrl + Shift + S Save all documents 

Ctrl + N Create a new document 

Ctrl + Shift + N Create a new project 

Ctrl + Shift + O Open the Project Manager 

Ctrl + I Check a document into the vault 

Ctrl + T Show the selected document in the Project tree 

Ctrl + R Regenerate the active document 

Ctrl + Shift + F Enable the front camera 

N View along normal 

Ctrl + P Print 

Enter Confirm an operation 

Del Delete the selected item 

Esc Cancel the active command or exit the dialog box 

F1 Display the TopSolid online help 

F2 Rename the selected item 

F5 Refresh the active document 

F11 Switch to full screen 

Alt + specified values 
Insert standard Windows symbols: 

- Alt + 157: Insert a diameter symbol (Ø) 
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Introduction 

Concepts addressed 

In this chapter, the objective is to understand how the project manager, projects and libraries work and finally how 
to create a project. 

Concept 

The documents generated by TopSolid are stored in a database called PDM (Product Data Management). Similar 
to a mailbox, the PDM allows you to centralize all the information required for studies. 

TopSolid has three levels of organization: 

-  Projects: They allow you to directly store your TopSolid documents and your external documents 
(Word, Excel, image, etc.). Depending on the company, a project can be a case, a production order, a 
company standard, a quote, etc. 

-  Libraries: They group elements that are common to several projects, such as railing ranges, extruded 
bars, materials, etc. TopSolid has hundreds of components (screws, nuts, bearings, extruded bars, etc.) in 
several standards (AFNOR, ANSI, CEN, ISO, etc.). 

The libraries can be freely enriched thanks to many websites such as TopSolid'Store, TraceParts, Cadenas, 
GrabCad, BIMObject, etc. 

-  Project Manager: It contains all the projects created. It allows you to group the projects by folder, sort 
the projects by property (customer name, delivery date, customer project identification number, etc.), 

preview the projects, and also search for projects. There is also a  library manager. 
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Project Manager 

• From the TopSolid 7 start page, click on the  Projects icon to display the project manager. 

 

The project manager dialog box appears. 

 

The project manager offers the following options (from left to right): 

- Creating a new project  

- Creating a new folder  

- Opening the selected project  

- Search bar  

- Displaying the template projects  

- Project previews  

Note: You can add or remove properties in the Project Manager's columns. You simply have to right-click on a 
column and select or delete the desired property. 
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• From the Project Manager, create three  folders. 

 

• Rename the created folders as follows: 

- Projects 
- Lost Projects 
- Estimate in progress 

Note: You can create sub-folders. 

To change the order in which projects are sorted, you simply have to click on a column heading and an arrow icon 
will appear on the right. 

Creating a new project 

• Right-click on the Estimate in progress folder and select the  New Project command. 

 

• From the Steel Templates folder, select Design Template, rename the project My Project, then click on  to 
confirm the operation. 

Warning: Never start with a blank project template because it does not contain any document template. 
Templates are necessary to perform mass calculations to obtain precise cutting lists, etc. 
If the wrong templates are used, you would have to restart the work or modify the parts one by one. 

• Double-click on the project name that you have previously created to open it. 

TopSolid then displays the Project tree. 
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Introduction to the Project tree 

Like all TopSolid trees, the Project tree includes an upper bar which contains options in order to display revisions, 
track documents, indicate which documents require updating, etc. 

 

The lower section of the tree contains a header document, in this case, called My project, which contains all the 
information about the project (customer name, reference, project type, etc.). This information can be used in all 
TopSolid documents. 

The references contain the referenced libraries for the active project and allow you to display only the elements 
useful in the current project. To add or delete the libraries, you simply have to right-click on the References node 

and select the  Reference Library command. 

 

The templates regroup document templates (unfolding, drafting, part, assembly, etc.) that can only be used in the 
current project. 

Each project has its own recycle bin, which prevents any unexpected deletion or deletion of used documents. 
  



TopSolid’Steel - Basics  Part 1 - Post Reassembly Design 

TopSolid   13 

Part 1 - Post Reassembly Design 

The objective of this exercise is to draw simple sheet metal parts, assemble them and then use them in 
manufacturing documents (bill of materials and drafting). 

Concepts addressed: 

- Creating the sheet metal parts 
- Assembling the parts using constraints 
- Creating a bill of material 
- Creating an unfolding 
- Creating parts and assembly draftings 
- Understanding and using document and project properties 
- Understanding the concept of vaulting and update cycles 

Concept 

The first way of designing in TopSolid consists of creating parts (or assemblies) independently of each other, then 
assembling them to produce a structure. This is called reassembly design or bottom-up design. 

In this exercise, we will successively design a plate and a railing post that we will assemble in another step. 

 

Creating a simple part: plate 

• From the Project tree, right-click on the My Project name and select the  Part command. 

TopSolid uses the document template provided with the project. 

Warning: Never start by using the Blank template document because it will not calculate the mass of the part nor 
its physical properties (surface, sheet metal thickness, etc.). 

• Right-click on the part document you have just created and select the  Properties command. Click on the 

Edit button. In the Description field, enter Plate and then click on  to confirm the operation. 

TopSolid automatically renames the part document with the same name as that which was entered in the 
description field. 
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Note: The  icon displayed in front of the document name and the asterisk (*) shown after the document name 
mean that changes were made to the document, but they are not yet saved. 

• Right-click in the graphics area and select the  Sketch command. 

TopSolid orients itself toward the selected plane. If no plane is selected, it uses the XY plane by default. In all cases, 
an XY frame is displayed in the center of the screen. 

 

When a sketch is created, the  Contour command is launched automatically and allows you to create a 
succession of segments. 

• From the 2D Sketch tab, select the  Rectangle command. 

• Select the  Parallel to axes option. 

• Click on the first point at the bottom left of the graphics area. 

When you move the mouse, TopSolid dynamically displays the dimensions of the rectangle. Centering constraints 
are directly applied if you try to create a rectangle centered on the frame. 

• Click on a second point at the top right of the graphics area to finish drawing the rectangle. 

• Double-click on the upper dimension and enter the following value. 

 

• Click on the  icon or press the Enter key on the keyboard to confirm the entry. 

• Finish constraining the rectangle by modifying the value of the second dimension as shown below. 
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Note: If the rectangle is not centered, some segments are displayed in pink. To center a dimension, you simply have 

to right-click on the desired dimension and select the  Define Centering command. Select the centering axis. 

 

• Right-click in the graphics area and select the  Sheet Metal on Sketch command. 
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• Adjust the thickness value to 10mm. 

Note: You can adjust the thickness value in different ways: either by entering the value in the corresponding field 
of the dialog box, or by double-clicking directly on the value label in the graphics area and adjusting the value, or 
by clicking and dragging the yellow arrow in the graphics area. 

 

Also note that other options can be displayed directly from the graphics area by using the contextual menu. 

• Click on  to confirm the operation. 

Note: The yellow border around the part means that the part is considered a sheet metal. TopSolid switches directly 
to the Sheet Metal tab and enables all of the commands in the tab. 

• Change the color of the part by right-clicking on it and selecting the  Attributes command. 

• Select a green color and click on  to confirm the operation. 
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• Create a drilling on the plate. To do this, right-click on the top face of the part and select the  Drilling 
command. 

TopSolid dynamically positions the drilling based on the position of the mouse. The hooking operation is performed 
on the nearest edges. If the cursor is placed in the center, a centering constraint is automatically added. 

• Click at the desired location to position the drilling by centering the hole across the width. 

 

Note: You can adjust the position of the hole by modifying the dimensions. To do this, double-click on a dimension 
and enter the desired value. 

• Select  Hole as the drilling type. Enter a drilling diameter of 11mm and select the  Through mode. 

 

•  Pin the command’s dialog box and click on  to confirm the operation. 

The pin allows you to keep the command open after confirming the operation. 
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• Perform the same drilling operation on the other side of the plate and  close the Drilling dialog box. 

 

Note: The command can be confirmed by double-clicking with the right mouse button in the graphics area and then 
pressing the Esc key on the keyboard to close the dialog box. 

Later in the training, we will see how to position several holes at the same time, how to repeat them or how to 
create symmetries. 

• Right-click on a vertical edge and select the  Angle Relief command to relieve the angles of the plate. 

 

• Select the other three angles using a bounding box, then select the Chamfers mode and enter an offset of 5mm. 

 

• Click on  to confirm the operation. 

• Save the plate by clicking on the  icon or by using the Ctrl + S keyboard shortcut.  
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Creating a bent part: railing post 

We will now create the post below. 

• From the Project tree, right-click on the My Project name and select the  Part command. 

• Right-click on the part document you have just created and select the  Properties command. 

• Click on the Edit button. In the Description field, enter Post and then click on  to confirm the 
operation. 

Note: It is not mandatory to name the parts. Clear names simply make it easier to find files and understand 
the bill of materials. To identify/group the parts, TopSolid has mechanisms to manage part geometry and 
properties. 

• Right-click in the graphics area and select the  Sketch command. 

• While keeping the  Contour command enabled, draw the following contour using the order shown 
below. 

 

The general idea is to approximately draw the desired shape without worrying about the dimensions. This step will 
come later. 

The pink segments indicate that the sketch is underconstrained, which means that there are missing dimensions 
and constraints to fix the shape in place. 
  

1 

2 

3 4 

5 

6 7 
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• Right-click in the graphics area while making sure that no element is selected, then select the  Constraint 
command. 

 

The  Constraint command allows you to add the dimensions but also, as its name indicates, to set the geometry 
constraints (perpendicularity, parallelism, coincidence, etc.). 

• Click on the segment as shown below and position the dimension. 

 

TopSolid offers to enter a value. 

• Enter 50mm and click on the  icon or press the Enter key to confirm the entry. 
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• Still using the  Constraint command, select the following two segments. TopSolid automatically switches to 
angle dimension. 

 

• Enter a value of 30°. 

• Using the Ctrl key, select the following two segments, right-click in the graphics area and select the 

 Parallelism command. 
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• Select the following two points, right-click in the graphics area and select the  Alignment command. 

 

Note: As in Windows, the Ctrl key allows you to select multiple entities. 

• Finish constraining the sketch as shown below. 
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The sketch should appear in blue to indicate that it is fully constrained. If this is not the case, it means that 
constraints are missing. 

The sketch is positioned on the XY plane by default. By convention, in the building industry, the Z axis often indicates 
verticality. 

• From the 2D Sketch tab, select the  Position Sketch command and select Absolute XZ Plane as the support 

plane and click on  to confirm the operation. 

• Right-click in the graphics area and select the  Sheet Metal on Sketch command. 

 

• Enter a sheet metal thickness of 10mm. As a reminder, it is also possible to pull on the yellow arrowhead to 
modify the value graphically. 

• Right-click on the following edge and select the  Flange command. 

 

• Enter an angle of 90° and a length of 60mm.  
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• Right-click in the graphics area and select the following options. 

 

The  icon allows you to define the position of the bend in relation to the selected edge (in this case, below the 
edge). 

The  icon allows you to select the bending radius, which in this case, is equal to the thickness of the sheet metal 
part. 

The  icon allows you to select the type of bend transition, which in this case, is the line type. 

All of these options are also available in the Flange dialog box. 

Note: To find out more about the different options available, you can display the TopSolid online help by clicking 

on the  icon or by using the F1 keyboard shortcut once the command has been selected. 

• Right-click in the graphics area and then click on  OK. 

• On the top face of the post, position a 7mm diameter drilling as shown below. 
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• In the Drilling dialog box, click on the  In/Out Counter Sinking icon. 

• Click on the Unspecified button in the Out counter sinking field, check the Out counter sinking box to change 
the value to True, then enter a length of 4mm. 

 

• Click on  to confirm the operation. 

 

• Change the color of the part by right-clicking on it and selecting the  Attributes command. Select the color 
light blue. 

• Save the plate by clicking on the  icon or by using the Ctrl + S keyboard shortcut. 
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Creating an assembly 

The goal now is to assemble the plate and the post in a single document that we will be able to use for the railings. 

• From the Project tree, right-click on the My Project name and select the  Assembly command. 

• Right-click on the assembly document you have just created and select the  Properties command. 

• Click on the Edit button. In the Description field, enter Post + Plate and then click on  to confirm the 
operation. 

• From the Assembly tab, select the  Inclusion command. 

• Select the plate part and check the Inclusion at origin box. 

 

• Click on  to confirm the inclusion. 

TopSolid switches to the positioning context in which you can add positioning constraints. 

 

Note: In our exercise, the plate is the first part of the assembly. Therefore, TopSolid fixes this part at the origin. You 

can remove the fixity by right-clicking on the part and selecting the  Unfix command. 
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• Confirm the positioning context either by clicking on the Positioning 1 button at the top of the screen or by 
right-clicking in the graphics area and selecting Positioning 1. 

 

Warning: The  icon cancels the positioning and therefore the inclusion of the plate. 

• Insert the post by  dragging the Post part document into the graphics area of the assembly. 

 

TopSolid switches once again to the positioning context. The color code is the same as for the sketches: 

- the underconstrained elements are displayed in pink; 
- the fully constrained elements are displayed in blue; 

The  Constraint command is automatically enabled. It allows you to add positioning constraints semi-
automatically. 

• Select the lower face of the post as the source by using the rotary picking technique. To do this, and to avoid 
rotating the view, position the cursor approximately on the face, hold down the left mouse button and click 
several times with the right mouse button. TopSolid then successively offers the geometries available under 
the cursor. Once the correct geometry has been selected, release the left mouse button. 
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Summary of rotary picking: 

-  hold down: Select the first entity under the cursor. 

-  + : Scrolling through the available entities. 

-  release: Final selection of the displayed entity. 

• Select the top face of the plate as the destination. 

 

TopSolid dynamically positions the post on the plate and adds a  Plan on plan constraint. 

 
• Hover the mouse over the label. From the label, you can reverse the constraint (the post will be upside down), 

add an offset value or edit the label via the contextual menu by selecting the  Edit command. 

Note: To move the part, you simply have to click on it, hold down the left mouse button and move the mouse. To 
rotate the part, you simply have to hold down the Alt key on the keyboard, click on the part, hold down the left 
mouse button and move the mouse. 
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• Exit the  Constraint command and orient the post as shown below using the Alt key. 

 

We will now position the post in the middle of the plate. To avoid doing calculations or taking measurements, you 
can create midplanes on-the-fly. 

• From the Assembly tab, select the  Plane on plane command. 

 

TopSolid asks you to select a source plane. The  icon allows you to create elements on-the-fly, including planes 
in this case. 
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• Click on the  icon and select  Midplane. Select the two external planes of the post as shown below. 

 

• Click on  to confirm the midplane. 

TopSolid then asks you to select the destination plane. 

• Click on the  icon and select  Midplane. Select the external planes of the plate as shown below. 

 

• Click on  to confirm the midplane. 

TopSolid adds a new constraint label and positions the post in the middle of the plate. If the plate is later modified, 
the post will still remain in the middle. 
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• Add a last  plane on plane constraint on the front face of the post by entering an offset value of 15mm. 
Click on the arrow to invert the gap distance if necessary. 

Note: In this case, you can also create mid-planes. 

 
The post should be displayed in blue to indicate that it is fully constrained. 

• Confirm the positioning context by clicking on the  button or via the contextual menu. 

•  Save the assembly document (Ctrl + S). 

Congratulations, your first assembly is complete! We will now see how it can be used in required documents for its 
production. 
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Bill of Materials 

As a reminder, the bill of materials list all the parts/sub-assemblies of an assembly. This list is fully customizable 
(filters, columns, level of detail, etc.) They also allow you to perform quick actions such as: 

- modify the properties (name, reference, etc.); 
- change material, coating and finishing; 
- launch an automatic part numbering; 
- create multi-drafts; 
- create multiple unfoldings; 
- generate printings. 

• Right-click on the Post + Plate assembly document's tab and select the  Bill of Material command. 

 

• Select the Multi-level template from the Steel Standard Templates - United States folder and click on  to 
confirm the operation. 

TopSolid creates the bill of materials and displays the following dialog box. 

 

• Click on  to confirm the operation. 
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You should obtain the following result. 

 

• Click on the first row of the bill of materials. 

In the lower part of the screen, TopSolid displays the details of the assembly. The name given to the document is 
clearly visible. This name is the one that appears in the PDM and can be different from the description that rather 
appears in the bill of material, in the plans, etc. 
Each of these fields can be parameterized, allowing you to automate their filling. 

Here are a few examples: 

- Name = Part Number - Description (1920 - 01 - 001 - Post) 
- Name = Description - Material (Post - S235) 
- Description = Name (Post) 

In this case, the document template used automates the Name field. By default, it displays the description. If you 
add a part number, it will display Part Number - Description. 

• On the Plate line, right-click in the Steel field of the MATERIAL column and select the Edit Material and Coating 
command. 

• In the Material field, select Steel S235 EN 10025. 

• Uncheck the No Coating box, select the Paint category and the Epoxy coating. 

 

• Click on  to confirm the operation. 
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Note: You can define the materials from the part itself, but also from the assembly in which it is located. We will 
see that later. 

• Repeat the manipulation on the post. 

In this BOM template, the Coating column does not exist. You can add additional information at any time. 

• To do this, right-click in the MASS column and select Add column. 

• Select Standard > Material > Coating > Coating Description properties. 

 

• Click on  to confirm the operation. 

•  Save the bill of materials document (Ctrl + S). 
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Drafting a part 

We will now draft the post as well as the plate. 

 

• Right-click on the Plate part document's tab and select the  Drafting command. If the Plate document is not 
open, you can right-click directly on the Plate document in the Project tree to access the command. 

 

• Select the Part A3 ISO Landscape template from the Steel Standard Templates - United States folder. 

TopSolid creates the drafting and offers to position the front view. 
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• Click approximately in the center of the plane. You can always reposition the view later. 

 

The following view should appear. 

 
 

- 1: Allows you to show or hide hidden lines 
- 2: Allows you to modify the type of rendering of the part (wireframe, shaded or realistic) 
- 3: Allows you to modify the local scale of the view. Only this view will be modified. If the scale of the plane 

is 1:2 and that of the view is 1:2, then the part is at the scale of 1:4. 
- 4: Allows you to rotate the part with respect to the axis at the center of the view 
- 5: Allows you to rotate the part with respect to the center of the view 

  

1 2 3 

4 
5 
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• Click on the lower part of the sphere to rotate the part as shown below. 

 

• Click on  to confirm the main view. 

TopSolid automatically launches the  Auxiliary view command which allows you to create the projection of the 
first view placed according to the location of the mouse. 

• Create the following top view and position it as shown below. 

 

• Create the following isometric view and position it as shown below. 

 

• Exit the command by pressing on the Esc key or by clicking on the  icon. 

Note: If you exit this command before you are finished, you can create these projections by right-clicking on a view 

and selecting the  Auxiliary View command.  
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•  Drag the isometric view under the other two views as shown below. 

 

• Right-click on the isometric view and select the  Edit command. 

 

• Then click on the icons below to hide the hidden edge lines and to show the part in shading render mode. 
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• Add the axes by right-clicking on the front view and selecting the  Automatic Axes command. Repeat the 
operation on the top view. 

 

• Right-click in the graphics area outside of the drawing and select the  Dimension command. Make sure that 

the pin  on the dialog box is enabled. 

Reminder: The first left click of the mouse allows you to select the entity to be dimensioned. The next left click 
allows you either to position the dimension, or to set the dimension in relation to another entity. 

• Select the upper and lower edges of the plate successively and then position the dimension to the left of the 
part. 

 

Once positioned, the dimension is displayed in black. 

• Select the left side of the plate and then the first drilling. 
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• Add the following dimensions. 

 

•  Exit the Dimension command. 

All of these dimensions can be created automatically. We will see this later in the training course. 

• From the Detailing tab, select the  Drilling note command and then select one of the drillings. 

 

TopSolid automatically groups similar drillings together. As for some dimensions, these annotations can be 
positioned automatically. 

•  Save the drafting document (Ctrl + S). 
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We will now repeat all the operations previously created on the post. 

 

• Right-click on the Post part document's tab and select the  Drafting command. If the Post document is not 
open, you can right-click directly on the Post part document in the Project tree to access the command. 

• Select the Part A3 ISO Landscape template from the Steel Standard Templates - United States folder. 

TopSolid creates the drafting and offers to position the front view. 

 

• Click on  to confirm the operation. 
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• Add the rest of the projections as shown below. 

 

You can change the paper size at any time. 

• Right-click on the drawing frame and select the  Edit command. 

 

• In the Predefined format field, select A4 ISO Portrait and then click on  to confirm the operation. 
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• Reposition the views in the frame. 

• Edit the isometric view, then click on the two icons as shown below to hide the hidden edges and switch the 
view to shading render mode. 

 

• Reposition the isometric view as shown below. 

 

• From the View tab, select the  Local Cross Section command and select the left view. 

 

• Click on  to confirm the operation. 

TopSolid asks which area should be cut. 

• Exit the Spline command using the Esc key and select the  Circle command. 
  



Part 1 - Post Reassembly Design  TopSolid’Steel - Basics 

44   TopSolid 

• Create a circle with a diameter of 100mm and position it as shown below. 

 

• Confirm the cutting sketch via the contextual menu or by clicking on the  button. 

• In the  Local Cross Section dialog box, indicate the cutting depth by clicking on one of the edges of the 
drilling. 

 

• Click on  to confirm the operation. 
 

• Add the axes by right-clicking on the same view and selecting the  Automatic axes command. 

 



TopSolid’Steel - Basics  Part 1 - Post Reassembly Design 

TopSolid   45 

• From the View tab, select the  Detail View command. Select the left view, then draw a circle as shown 
below. 

 

• Confirm the detail sketch. 

• Position the view under the isometric view. 

 

• Adjust the scale factor. To do this, double-click on the label of the view and enter 5. 

 

• Click on  to confirm the operation. 

Note: This scale factor will be added to that of the drawing. 

• Add the  automatic axes to the detail view. 

• Add the following  dimension. 
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• From the Detailing tab, add a  drilling note on the hole. 

 

• From the Detailing tab, select the  Composite Dimension command. This type of dimensioning allows you 
to set several dimensions from the same reference. 

• Select the  Ordinate mode and the Vertical direction, then on the face view, select the base of the post as 
the origin geometry and the two elements as shown below as the measure geometries. 

 

• Add the following three  dimensions on the left view. 

 

•  Save the drafting document (Ctrl + S).  
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Unfolding 

We will now unfold the post and integrate it into its detail drafting. 

• Right-click on the Post part document's upper tab and select the  Unfolding command. If the Post document 
is not open, you can right-click directly on the Post part document in the Project tree to access the command. 

 

TopSolid creates a new unfolding document. 

• Click on  to confirm the unfolding operation. 

 

The unfoldings are in 3D by default. You can export them directly in DXF/DWF and DSTV (.nc1) formats or even 
integrate them in a drawing. You can also customize the unfolding rules used (see Annexes). 

•  Save the unfolding document (Ctrl + S). 

• Return to the post drafting document. 

• At the bottom left of the graphics area, click on the  icon to add a new page. 
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•  Drag and drop the unfolding document into the document. 

 

• Position the view in the drawing and click on  to confirm the operation. 

• From the Detailing tab, select the  Automatic Bend Notes command and select the view. 

• Reposition the note outside the view if necessary. 

 

•  Save the drafting document (Ctrl + S). 
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Drafting an assembly 

Now that the detail draftings are created and the drafting mechanism is understood, we will be able to draft the 
Post + Plate assembly. 

 

• Right-click on the Post + Plate assembly document's tab and select the  Drafting command. 

Reminder: If the assembly document is not open, right-click directly on the Post + Plate document assembly in the 
Project tree. 

• Select the Assembly A3 ISO Landscape template from the Steel Standard Templates - United States folder. 

• Position the views as shown below. 

 

• Add the  automatic axes on each of the views except the isometric view.  
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• From the Detailing tab, select the  Automatic Dimensions command. 

The following two modes are available: 

-  Enclosing dimensions: Allows you to add the enclosing dimensions along X and Y. 

-  Length dimensions: Allows you to dimension the length of the profiles. 

-  Cutting dimensions: Allows you to dimension the cutting angles of the profiles. 

• Select each of the views except the isometric view. Make sure that the pin  in the dialog box is enabled; this 
will avoid having to relaunch the command to switch from one view to another. 

 

Note: You can hide redundant or uninteresting dimensions. To do this, right-click on the dimension to be hidden 

and then select the  Hide command. 

• From the Detailing tab, select the  Bill of Material Table command. 

Warning: The Post + Plate bill of materials document must be opened in order to create the bill of materials table. 

• Position the BOM table by clicking either on the two vertices of the title block as shown below (from left to 
right), or directly on the title block’s upper line. 
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• In the dialog box, check the Add line for set box. TopSolid will then add a line for the assembly, which will allow 
you to recover any properties of the assembly (mass, etc.). 

• Click on  to confirm the BOM table. 

You should obtain the following result. 

 

• From the Detailing tab, select the  Automatic BOM Index command. Select the isometric view and click on 

 to confirm the operation. 

 

TopSolid has added a bill of materials index per part. 

The indexes are fully customizable. For example, you can directly integrate information from the bill of materials or 
even from the part in the index. 

• To do this, right-click on an index and select the  Edit command in the Automatic indexing section. In the 
Style field, select QtyDesc_MatCoatMass from the drop-down list. 

 

•  Save the drafting document (Ctrl + S).  
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Updating the project information 

In the default title block delivered with TopSolid, a section is allocated to the project. This information is 
automatically inherited from the project itself. In other words, if you want to reuse a set (parts, assembly, bill of 
materials, drafting, etc.), you simply have to copy and paste it into a new project. The draftings will be automatically 
updated with the new project information. 

• From the Project tree, double-click on the My Project name. 

• Modify the Name field by entering My First Project. 

• Modify the Description field by entering My First Project. 

• Modify the Part Number by entering 109 - 001. 

•  Save the project (Ctrl + S). 

• Return to one of the drafting documents. The Project area has indeed inherited the modifications in an 
associative way. 
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Organizing the project 

As you will have noticed, a complete project generates a number of different documents. The flexibility of the PDM 
allows, without losing the link, you to make modifications such as renaming a document, moving it to another 
folder, etc. Therefore, you can focus on modeling at first and then rename the parts and organize the project at the 
end. 

• From the Project tree, create a folder named Post + Plate. To do this, right-click on My first project name and 

select the  Folder command. 

• In the Post + Plate folder, create the following four folders in the same way. 

 

•  Drag the following documents into the appropriate folders. 

 

When creating a project, you can have a pre-established folder structure. This saves precious time, but above all 
guarantees a certain homogeneity. 
Finally, non-TopSolid files (images, Excel, Word, etc.) can also be integrated into the project by dragging them from 
Windows and dropping them into the TopSolid project. 
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Check in 

So far, we have been content with creating document backups. TopSolid manages its backups document by 
document. 

• In the Project tree’s icon bar, click on the  Show backups icon. 

 

An  icon appears to the left of the documents allowing you to display the backups. 

 

You can restore a backup by right-clicking on the desired backup and by selecting the  Restore Backup 
command. 

Warning: Do not do this as part of this exercise. 

 

A backup is kept by default. To adjust the number of backups, you simply have to select the Tools > Options > PDM 
> PDM command and adjust the value in the Number of backups without back references to keep field. Increasing 
the number of backups decreases the performance of TopSolid at each backup. 

In server mode, everything that has been created so far is visible only to us. 
In order to benefit from the automatic index management system and to make these documents available to other 
users, you have to check them into the vault. You can check them into the vault document by document, or by 
selecting a folder or even an entire project. 

Warning: When a document is checked in the vault, TopSolid deletes all the backups that were not used by other 
documents. 
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When to check elements into the vault? 

There are no rules. Checking an element into the vault can be done at the end of a design stage, which is our case, 
at the end of the day, when exiting TopSolid, etc. It really depends on the person and the context. 

• Right-click on My first project name and select the  Check In command. 

A dialog box appears that lists all the documents concerned. TopSolid may offer to update certain documents. If 
this is the case, you simply have to click on the Update button and then start again. 

• Click on  to confirm the check-in. 

The  icon then appears in front of the name of each document/folder in the vault. 

Understanding how updates work 

Most of the time, a study has to evolve. TopSolid facilitates update cycles thanks to the PDM. 

• From the Project tree, open the Post part document. 

• Double-click on the part. All the dimensions are displayed. 

• Double-click on the 1000mm height dimension and then subtract 40mm. 

 

TopSolid displays the result while keeping the calculation history. 

•  Save the part document (Ctrl + S). 

• In the Project tree, make sure that the following icons are selected. 

 

TopSolid dynamically displays an  exclamation mark in front of each document requiring an update. When 
opened, the document will update automatically. 

• Right-click on the Post + Plate folder and select the  Update command. 

A dialog box appears that lists all the documents to be updated. 

 

• Click on  to confirm the update. 

All documents are up to date with the new post height. The relevant documents have also been removed from the 

vault; the  icon has disappeared and has been replaced by this  icon. 
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In server mode, the documents will remain visible to other users, but will be locked indicating that the document 
is being modified. 

• Right-click on the Post + Plate folder and select the  Check In command. 

Each time a document is modified and placed in the vault, TopSolid increments the minor revisions of the 
document. 

 

As with backups, revisions are stored below the document. You can restore one of the revisions to return to a 
previous state. 

Understanding how deletions work 

We have just seen that TopSolid's PDM provides design flexibility. Its role is also to secure your files. Therefore, it 
will be completely impossible to delete a document that is used in another document (a part used in an assembly, 
for example). 

• Right-click on the Post + Plate folder and select the  Copy command or use the Ctrl + C keyboard shortcut. 

Note: Copying an entire folder (draftings, parts, assemblies, etc.) allows you to keep the links between the 
documents. 

• Right-click on My first project name and select the  Paste command or use the Ctrl + V keyboard shortcut. 

TopSolid creates a copy of the complete folder. 

 

Note: No link is kept from the initial Post + Plate folder. 

• In this new folder, delete the plate by pressing the Delete key or by right-clicking on the Plate document and 

selecting the Deletion >  Delete command. 

 

TopSolid warns you that the document is being used, but still allows it to be placed in the recycle bin. 
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• Click on  to confirm the deletion and click on Yes to confirm the following message. 

 

The document is now in the recycle bin. 

• From the Project tree, open the Recycle bin node. 

• Right-click on the Recycle bin node and select the  Empty Recycle Bin command. 

 

TopSolid prohibits the deletion of the document. 

 

• Close the dialog box by clicking on the  icon. 

• In the Project tree, delete the Post + Plate - Copy folder with the Delete key or via the contextual menu. 

•  Empty the recycle bin again. Deletion is now possible. 
  



Part 2 - In-Place Design of the Railing  TopSolid’Steel - Basics 

58   TopSolid 

Part 2 - In-Place Design of the Railing 

The purpose of this exercise is to design a railing based on an environment and to create all the manufacturing 
draftings. 

Concepts addressed: 

- Understanding the concept of background document 
- Understanding in-place design 

Concept 

You now know how to produce assemblies from parts created separately and how to produce all of the associated 
production documents. This operation is ideal to include a fairly standard or commercial part. 

TopSolid offers another mode of creation: in-place design. 

This working method allows you to create parts and assemblies that are linked to each other. This design mode is 
useful when the parts are strongly constrained by their environment. 
In this case, if the environment changes, all the parts and assemblies will be modified while respecting your 
constraints. 
A stair will be recalculated according to its hopper, a railing according to the balcony, a door according to its 
opening. 

The following exercise deals with the layout of the following balcony. 
 

 

We will start by creating the environment and then use it as a background document to position the posts. We will 
then create the fillings, the handrails, the fixings, etc. Finally, we will assembly the railing in its environment to 
create a layout drafting. 
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Creating the environment 

• Right-click on My first project name and select the  Part command. 

• Right-click on the part document you have just created and select the  Properties command. Click on the 

Edit button. In the Description field, enter Balcony and then click on  to confirm the operation. 

• Right-click in the graphics area and select the  Sketch command. 

• Keeping the  Contour command enabled and then draw the following contour. 

 

Warning: To create the 3000mm dimension, click on the line. Depending on where you position the mouse, 
TopSolid offers a dimension that is either parallel, projected on X or projected on Y. 

Parallel 

 

Projected on X 
axis 

 

Projected on Y 
axis 

 

• Consider the case of a parallel dimension. 

• Still in the sketch, right-click in the graphics area with no active selection and select the  Extruded command. 
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• Extrude the sketch to a height of 200mm. 

 

Generally, this type of structure has a slope. This can be done in several ways, including the following. 

• From the Shape tab, select the  Draft command. 

• Enter an angle of 1.5%. Make sure that you add the % sign, otherwise the value will be expressed in degrees 
(°). 

• In the Plane field, select the front face of the balcony. 

• In the Faces field, select the upper face. In this case, the 200mm dimension at the end of the balcony will be 
kept. 

 

• Click on  to confirm the operation. 

Now we will create the wall. 

• Right-click on the lower face of the part and select the  Sketch command. You can use the rotary picking 
technique to select the face without rotating the camera. 

Reminder:  hold down: Select the first entity under the cursor (the top face). 

   + : Scrolling through the available entities. 

    release: Final selection of the displayed entity (the bottom face). 
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• Exit the Contour command. 

• From the 2D Sketch tab, select the  Project command. 

• Select the  Curves or edges mode and click on the following two edges. 

 

• Click on  to confirm the projection. TopSolid draws a line for each selected edge. 

• Still in the Sketch, select the  Thickened command from the 2D Sketch tab. 

 

As its name suggests, this command allows you to add thickness to a set of lines, centered on one side or on both 
sides. It also allows you to manage the extremities. To find out more about this command, you can refer to the 

TopSolid’s online help by clicking on the  icon or by using the F1 key once the command has been selected. 
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• Select the previously created sketch. Select the  One side type, enter a thickness value of 210mm, then 
select Lines from the Extremity joints drop-down list. The other joints are used to make oblong holes, for 
example. Make sure that the Construction box is unchecked. 

 

• Click on  to confirm the operation. 

• Right-click in the graphics area and select the  Boss command. 

• Enter a height of 1500mm. 

 

Note: If the boss does not work, select Absolute Z axis in the Direction field. 

• Click on  to confirm the boss. 
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You should obtain the following result. 

 

•  Save the part document. 

Creating the background document 

We will now use the environment as a background document; it will be used for the design but will not appear in 
the bill of materials nor drafting documents. 

A background document can be of different types: 

- Part 
- Assembly 
- 2D Drawing 
- Etc. 

In our case, the background document is a part, but it could have been an assembly modeled in TopSolid or even 
an assembly resulting from a 3D file import (IFC, Rvt, Step, etc.) or a 3D scan (on-site measurements or scan). 

You can also change and even break the link with the background document to make the future railing independent. 

• Right-click on My first project name and select the  Assembly command. 

• Right-click on the assembly document you have just created and select the  Properties command. Click on 

the Edit button. In the Description field, enter Railing and then click on  to confirm the operation. 

• At the top left of the screen, click on the  TopSolid 7 icon and select the File >  Background Document 
command. Select the Balcony document. 

 

The Background Document command only displays the open documents in the drop-down list. Therefore, make 
sure that the Balcony part document is open before selecting the command. 

• Check the Transparent option, then click on  to confirm the operation. 

We can now design the railing. 
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Creating the railing 

Introduction to constrained linear pattern 

In TopSolid, a repetition is divided into two parts: 

- what you can repeat (Entities and Repetition fields); 
- how to repeat it (Pattern field). 

A pattern can be common to several repetitions, so you do not have to redefine it each time. 

Usually, the object to be repeated is positioned and then the pattern is created. In metalwork, often times the 
inverse is true, because the position of the object is given by the pattern itself (posts, bars, etc.). 

TopSolid includes a particularly popular pattern to calculate the distributions: the  constrained linear pattern. 

This has two installation methods. 

Icon Description Use Image 

 Between points 
Ideal for calculating a repair 

between elements (walls, posts, 
etc.) with a certain orientation. 

 

 On plane 

Application centered on a plane 
or with an offset from the edge. 
Useful for positioning elements 
on a plane (post on concrete, 
screws on sheet metal, etc.). 

 

And different calculation methods: 

Icon Description Use Image 

 Fixed count 

Divide the distance (D) by the 
number entered. Ideal for 

evenly distributing elements 
(screws, supports, drillings, etc.). 
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Maximum 
distance 

Keeps a maximum distance 
between the instances (S). The 
Thickness (e) option allows you 

to take the thickness of the 
repeated element into account. 
Ideal when the distribution must 

comply with a standard or 
resistance constraints (railing, 
structural posts, railings, etc.).  

 Step 

Divide the distance by a step (P) 
with or without a quantity. 

The distance is respected. The 
margins (d1 and d2) allow you to 

precisely position the first 
instance or to give a minimum 

distance to the extremities. 

 

 Unit Step 
Equivalent to Step mode but 

with a module (n). 
 

 

For more information about the  Constrained linear pattern command, refer to the online help. 

Post distributions 

• From the Construction tab, select the  Constrained Linear Pattern command. 

• Select the  On Plane mode. 

• In the Direction field, select the edge as shown below. 

 

This field defines the direction in which the distribution of the posts will be calculated. 
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• In the Support plane field, select the face as shown below. 

 

The support plane will define the orientation of the post. In this case, it will be perpendicular to the ground and 
therefore be slightly inclined. 

Note: If we had wanted to position the vertical post with a wedging, we would have had to recreate a correctly 

oriented plane using the  icon. 

• In the Start geometry and End geometry fields, select the following planes. 

 

We will now position the posts in relation to the edge of the balcony. 

• Open the  Axis Position dialog box and select the  Offset mode. 

• In the Reference geometry field, select the plane as shown below. 

 

• Make sure the Offset box is checked and enter a value of 40mm. 
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TopSolid displays a preview of the post distribution. 

• Make sure that the yellow arrow in the center is pointing toward the inside of the balcony. 

 

Note: If there had been no slope, TopSolid would have automatically selected all the planes necessary for the 
calculation and positioning of the pattern. 

• Open the  Distribution dialog box and select the  Maximum distance mode. 

• Enter a maximum spacing of 1000mm, uncheck the Thickness box and check the Edge to edge box. 

 

Note: In the image above, the orange frame on the left indicates the position of the first post and the orange frames 
on the right indicate the repeated instances (in this case, four). 

You can now add offsets to correctly position the first and last post. 
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• Select Distinct margins from the drop-down list, then check the Start margin and End margin boxes. Enter a 
value of 100mm for each of the margins. 

 

Note: You can also enter a value for the margins and offset directly in the graphics area. 

•  Pin the dialog box, then click on  to confirm the operation. 

We can now create the second pattern. 

• Fill in the following fields for the constrained linear pattern. 

Direction 

 

Support plane 

 

Start geometry and End geometry 

 

Offset value: 40mm 

 

• Click on  to confirm the operation. 



TopSolid’Steel - Basics  Part 2 - In-Place Design of the Railing 

TopSolid   69 

Now that the patterns have been calculated, we can insert the posts and repeat them. 

• From the Project tree,  drag the previously created Post + Plate assembly into the graphics area of the Railing 
document. 

TopSolid switches to the positioning context. You can then add constraints to the inserted element in order to 
position it in the assembly. 

• From the Assembly tab, select the  Frame on Frame command. 

• In the Source frame field, select Post + Plate from the drop-down list. 

• In the Destination frame field, select the frame as shown below. 

 

• Click on  to confirm the positioning. 

• From the Construction tab, select the  Repetition command. 

• Select the previously included post as the entity to be repeated. Click in the Pattern field to enable it. Select a 
point of the constrained linear repetition as shown below. 

 

• Click on  to confirm the repetition. 
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• From the Project tree,  drag the previously created Post + Plate assembly into the graphics area of the Railing 
document. 

• From the Assembly tab, select the  Frame on Frame command. 

• In the Source frame field, select Post + Plate from the drop-down list. 

• In the Destination frame field, select the frame as shown below (the one with a cross). 

 

• From the Construction tab, select the  Repetition command. 

• Select the previously included post as the entity to be repeated. Click in the Pattern field to enable it. Select a 
point of the constrained linear repetition as shown below. 

 

• Click on  to confirm the repetition. 
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You can see that the two posts are colliding. 

 

You can modify the patterns to adjust your work at any time. 

• Right-click on one of the repeated posts along the longest length of the balcony and select the  Edit Pattern 
command. 

 

• In the Start margin field, adjust the value from 100 to 160mm, then click on  to confirm the operation. 

TopSolid automatically adjusts the positioning of the first post and calculates the repetition. 

• Proceed in the same way for the second repetition, but this time by modifying the end margin. 
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We will now test the repetition by modifying the environment. 

•  Save the Railing assembly document. 

• Return to the Balcony part document. 

• Double-click on one of the side faces of the slab to display the dimensions. 

 

• Double-click on the 3000mm dimension and adjust the value to 3850mm. 

The balcony document needs to be updated. 

• Double-click on one of the side faces of the slab to hide the dimensions. This action is not mandatory, but you 
should be aware that the background document keeps the display of the document as is. In other words, if you 
leave the dimensions displayed, when you return to the railing assembly, the dimensions will also be visible. 

•  Save the Balcony part document. 

• Return to the Railing assembly document. You will notice that a post has been added. 

If you wish to check the center distance of two posts, TopSolid has a fast measuring system. You simply have to 
press and hold down the Ctrl key and select the faces as shown below. The distance is then displayed in the status 
bar at the bottom right of the screen. 
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TopSolid also has an advanced measurement system. You simply have to right-click in the graphics area with no 

active selection and the select the  Analyze Geometry command. 

For more information, refer to the online help.  
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Creating the right filling 

• Right-click on the face as shown below and select the  Sketch command. 

 

• Draw the following sketch. 

 

• Confirm the sketch. 

• Right-click on one of the segments and select the  Extruded bar command. 
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• In the Family field, select Full flat section NF A 45-005. 

• In the Code field, select 40 x 10. 

• Select the  Sketch/Segment/Profile/Edge/Face mode. This mode allows you to select a segment, a profile 
or a complete sketch. 

The four modes below deal with positioning. 

    

Sketch/Segment/Profile/
Edge/Face 

Two Points Frame and Length Constrained positioning 

 
   

• In the Profile field, select the previously created sketch. 

Each extruded bar has a reference direction and an orientation in the form of an angle. 

• Adjust the orientation to 90°. 
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The lower part of the dialog box deals with the positioning of the extruded bar. Each extruded bar has nine 
standard positioning points. 
You can select the point either in the dialog box or directly in the graphics area. 

  

• Position the extruded bars as shown below so that they are centered on the post. 

• Enter a vertical shift of -5mm, otherwise the extruded bars will be positioned directly above the posts. 

 

• Click on  to confirm the operation. 
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We will now create a bar with a full circular section of Ø12mm with a maximum distance of 110mm. 

• From the Construction tab, select the  Constrained Linear Pattern command. 

• Select the  Between points mode. 

• Select a point in the center of the left edge of the previously created low extruded bar as the starting point. 

• Select a point in the center of the right edge of the previously created low extruded bar as the end point. 

• Select a vertical edge of the left post as the vertical direction so that the bars are parallel to the posts. 

• Select the  Maximum distance distribution mode. 

• Adjust the maximum spacing to 110mm. 

• Check the Thickness box and enter a value of 12mm. This value corresponds to the width of the bar. 

• Uncheck the Edge to edge box and select Equal margins. 

 

• Click on  to confirm the pattern. 

• From the Modeling tab, select the  Extruded Bar command. 

• Select the Full Circular Section, NF A 45-003 family and the 12 code. 

• Select the  Frame and Length mode. 

• In the Destination frame field, select the frame as shown below. 
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We could measure the height of the bar with the measuring tool. Unfortunately, if the gap between the two rails 
changes, you will have to think about adjusting the height of the bar. 
TopSolid is able to keep this measurement by creating a parameter. 

• In the Length field, click on the  icon and then select  Distance Parameter. 

• In the Name field, enter BarHeight. This will make it easier to identify the parameter. 

• Select the bottom face of the top rail as the first geometry and the top face of the bottom rail as the second 
geometry as shown below. 

 

• Click on  to confirm the parameter. 
 

• In the Extruded bar dialog box, make sure that the shift values are set to 0mm. 

The bar is normally correctly dimensioned. 

 

• Click on  to confirm the inclusion of the extruded bar. 
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• From the Construction tab, select the  Repetition command. 

• Select the bar as the entity to be repeated and select the previously created constrained linear pattern. 

 

• Click on  to confirm the repetition. 

We will now repeat the rails and the bar. In order to avoid redefining everything, we will build on what has already 
been created with the posts. 

• From the Construction tab, select the  Repetition command. Select the two rails as the entities to be 
repeated. In the Repetitions field, select the bar. 

• In the Pattern field, click on the  icon and select  Pattern. 

• Click on one of the posts, then click on  to confirm the operation. 

 

This step allows you to derive the pattern of the posts. This is mandatory if the filling pattern is to be modified 
without affecting the pattern of the posts. 

 

• Click on  to confirm the repetition. 
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There is an excess filling. Indeed, since we used the pattern of the posts, the quantity is the same. 

• Right-click on one of the repeated fillings and select the  Exclusion command. Select the last occurrence as 
shown below. 

 

• Click on  to confirm the exclusion. 

You should obtain the following result. 

 

Note: You can return to the Balcony part document at any time to vary its dimensions and therefore confirm your 
parameters. 
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Creating the left filling 

On the left side, we will create a sheet metal that will make the connection between the posts. 

 

• Right-click on the front face of the life side of a post as shown below and select the  In Place Part command. 

 

TopSolid creates a new part document and switches to the sketch context. 
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You can reorient the sketch so that the vertical is that of the posts and not that of the stage. 

• To do this, from the 2D Sketch tab, select the  Position Sketch command. 

• Select the Vertical Direction option and select one of the edges of the post as shown below. The arrow must 

be pointing upward; to reverse it, click on the  icon to the left of the Vertical Direction field. 

 

• Click on  to confirm the operation. 

• Draw the sketch shown below using the  Rectangle command. 

 

Note: If automatic dimensioning is enabled, you simply have to delete the height dimension of the rectangle in 
order to constrain it with respect to the post and the ground. If the post is modified later, the rectangle will follow. 
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• Right-click in the graphics area, making sure that there is no active selection and then select the  Sheet 
Metal on Sketch command. Enter a thickness of 1.5mm and an offset of 5mm. 

 

• Click on  to confirm the operation. 

• Right-click on the sheet metal and select the  Attributes command to change its color. Select the color pink. 

• Right-click on the inner edge of the sheet metal part and select the  Flange command. 
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• Select the lower inner edge as well. 

 

• Click on  to confirm the operation. 

• Via the contextual menu, add two  hem bends as shown below. 

 

• Click on  to confirm the operation. 

The part is now complete. 
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• Return to the assembly editing by clicking on the  button or via the contextual menu without 
active selection. 

 

Creating the handrail 

• From the Modeling tab, select the  Extruded Bar command. 

• Select the Hollow Square Section, ISO 4019 family and the 40 x 2 code. 

• Select the  Two points mode and select the two points as shown below. 
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By default, TopSolid selects the Z axis as the reference direction. Since the balcony has a slope, you will have to 
redefine this orientation. 

• In the Reference Direction field, select the top face of the railing. 

 

Warning: TopSolid keeps the values which were last used by the command. Make sure that the shifts are set to 
0mm. 

• Click on  to confirm the inclusion of the extruded bar. 

• Repeat the operation on the second handrail. 
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• In the Reference direction field, select the top face of the railing. 

 

• Click on  to confirm the inclusion of the extruded bar. 

• Right-click on one of the extruded bars and select the  Miter Trim command. 

• Select the second extruded bar. 

 

• Click on  to confirm the operation. 
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• Right-click on the left handrail and select the  Planar Trim command. 

• Select the left wall as the trimming plane. 

 

• Click on  to confirm the operation. 

• Repeat the operation on the right wall. 

 

• Click on  to confirm the operation. 

We will now create the wall fixing plates. 

• Right-click on the face of the left wall and select the  In Place Part command. 

 

TopSolid creates a new part document and switches to the sketch context. 
  



TopSolid’Steel - Basics  Part 2 - In-Place Design of the Railing 

TopSolid   89 

• At the top right of the screen, click on the arrow as shown below. 

 

• Select the  Cut mode. TopSolid cuts everything between the camera and the sketch plane. 

• Draw the sketch as shown below. 

 

Note: The extruded bar has a slight angle due to the slope of the balcony. This being weak, we will not need to 
reorient the sketch in relation to the extruded bar. 

• Right-click in the graphics area, making sure that there is no active selection and then select the  Sheet 
Metal on Sketch command. Enter a thickness of 10mm. 

 

• Click on  to confirm the operation. 

• Right-click on the sheet metal and select the  Attributes command to change its color. Select the color light 
purple. 

• Right-click on the following edge and select the  Angle Relief command. 
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• Select the second edge as shown below. 

• Select the Chamfers and Identical Offsets options and then enter an offset of 5mm. 

 

• Click on  to confirm the operation. 

• Right-click on the top face of the part and select the  Drilling command. 

• Create a Ø9mm drilling positioned as shown below. 

 

• Click on  to confirm the operation. 

• Confirm the in-place editing context. 

• Right-click on the left handrail and select the  Planar Trim command. 

• Select the top face of the plate as the trimming plane. 
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• Duplicate the plate. To do this, press and hold down the Ctrl key and then  drag the part. 

 
Note: You can also use this tip to copy operations in a part document. 

TopSolid switches to the positioning context. 

 

• Position the plate using the following constraints. 

• Select the back face of the plate, then the right wall. 

 

Warning: Remember that the handrail is not perpendicular to the wall.  
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• Select the edge as shown below, then the front face of the handrail. 

 

• Select the upper edge of the plate, then the upper face of the handrail. 

 

The plate is displayed in blue, which means that it is fully constrained. 

• Confirm the positioning context. 

• Right-click on the right handrail and select the  Planar Trim command. 

• Select the top face of the plate as the trimming plane. 

 

• Click on  to confirm the operation.  
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During assembly, the post may interfere with the positioning of the screw on the plate side. The plate on the left 
handrail is the same as that on the right handrail, but you can change the right plate. This concept is called 
"derivation for modification". The plate can be modified while keeping a link with the original part. 

A second possibility is the "copy for modification." In this case, the link is broken and the plate is completely 
independent. Please note, this action is irreversible and only works on parts that were not created in place, which 
is not our case. 

To fully understand how this works, here are a few examples of modifications made to the different cases. 

 Action Original Plate Repositioned Derived for 
modification 

Copied for 
modification 

1 Adjusting the height of the 
original plate     

2 Offsetting the drilling of the plate 
derived for modification     

3 Adjusting the diameter of the 
original plate     

4 Adjusting the width of the plate 
copied for modification    

 

1: Only the plate copied for modification is not affected by the change in height. 
2: No modified plate apart from the one derived for modification. 
3: Only the plate copied for modification is not affected by the change in diameter. 
4: No modified plate apart from the one copied for modification. 

• Right-click on the right plate and select the Others >  Derive Part for Modification command. 
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• Select the Derived Part (New designation) template. This will allow you to freely change the designation of the 
plate. 

• Double-click on the plate to edit it in place. 

• Right-click on the plate and select the  Attributes command to change its color. Select the color pink. 

• From the Shape tab, select the  Faces Modification command. 

• Select the  Move mode. Click in the Faces field to enable it and select all of the faces as shown below. 

 

• Select an edge of the plate as the direction and enter a value of 10mm. 

 

• Click on  to confirm the operation. 

Note: This command also allows you to resize the parts (adjusting thickness, drilling diameter, dimensions, etc.) by 
disregarding the previously performed operations on the part. It is therefore very useful to modify the parts which 
have been imported that were not designed in TopSolid. 
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• Return to the assembly editing by clicking on the  button or via the contextual menu without 
active selection. 

 

Modifying a design step from the Operations tree 

Our design is now complete. We saw previously that making a change to the background document (balcony) will 
automatically change the railing. 

You can also to go back to a previous design operation using the Operations tree which contains the chronology of 
everything that has been done on the document. 

• Return to the Railing document or open it if it has been closed. 

• Display the Operations tree. If the tree is not visible on the screen, click on the  TopSolid 7 icon and select 

the Display >  Operations command. 

• You can reposition the Operations tree. To do this, click on the upper bar of the tree, then while holding down 

the left mouse button,  drag the tree to the desired location. 

 

TopSolid offers four types of positioning depending on where you drag the tree. 

- Hooking on one side (left, top, right or bottom). If you get close to an edge, TopSolid then offers to hook the 
tree on it by displaying a blue frame with arrows. 
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- Freely position outside of the TopSolid window (ideal for use on multiple screens). You simply have to 

 drag the tree outside of TopSolid. 

 

- Grouping with an existing tree (here, the Project tree). You simply have to  drag the tree onto the central 
part of an existing tree. TopSolid then adds a tab at the bottom of the tree. 

 

- Mosaic on an existing tree. You simply have to  drag the tree onto the upper or lower section of an existing 
tree. 
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• Place the Operations tree on the left. 

Here, we will therefore find all the operations performed in the active document, from the most recent to the 
oldest starting from the top. 

• From the Operations tree, double-click on the Constrained Linear Pattern (Pattern 1) operation to edit it. 

• Adjust the offset from 40mm to 80mm and the starting margin from 160mm to 200mm. 

 

• Click on  to confirm the pattern. 
 

• From the Operations tree, double-click on the Constrained Linear Pattern (Pattern 2) operation to edit it. 

• Adjust the offset from 40mm to 80mm and the end margin from 160mm to 200mm. 

 

• Click on  to confirm the pattern. 
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You can also display the assembly in a previous state. 

• From the Operations tree,  drag the Modeling Stage cursor between the Solving (Sketch 2) operation and 
the Repetition 2 operation. 
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In the tree, all the operations located after the cursor appear in gray and no longer appear in the graphics area. 

 

In our case, we have just finished positioning the posts. 

As you can see, a design can involve a large number of steps. In order to facilitate the modification of a project or 
its subsequent reworking, you can organize the Operations tree. 

• From the Operation tree, select the Repetition 2 operation, press the Shift key and while holding down the 
key, select the Constrained linear pattern (Pattern 1) operation. TopSolid selects all the elements present 
between these two operations. 

• Right-click in the graphics area and select the  Folder command. 

• Rename the folder Posts. 

 

We have seen previously that to go back to a previous operation you simply have to move the Modeling Stage 
cursor. Another method exists. 

• Right-click on the Extruded bar 4 operation (this operation must correspond to the left handrail) and select the 

Others >  Insert Before command. 
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• Using the Shift key, select all the operations between the Posts folder and the Modeling Stage cursor, then 

right-click and select the  Folder command. 

• Rename the folder Filling. 

 

When the Modeling Stage cursor is not positioned at the end, TopSolid displays the  icon on the document tab 
to warn the user. 

 

• Click on the  End inserting icon to move the cursor back to the top of the tree. 

• Create a last folder called Handrail with the remaining operations. 

 

 

Note: A final tip to move the Modeling Stage cursor is to click on it and, while holding down the Alt key, press the 
up or down arrow on the keyboard. 
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There are a number of options that can be enabled/disabled at the top of the Operations tree. 

 

You will find below the description of each option (taken from the TopSolid online help). 
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Entities tree 

TopSolid has another essential tree: the Entities tree. 

• To display the Entities tree, click on the  TopSolid 7 icon at the top left of the screen and select the View > 

 Entities command, or right-click on the upper bar of an existing tree and select  Entities. 

 

• Position the Entities tree on the Operations tree. 

The Entities tree automatically regroups all the created entities, which can be planes, sketches, parameters, etc. 

• From the Entities tree, open the Parameters folder. We find the BarHeight parameter. 

• Open the Sketches folder, right-click on Sketch 2 and select the  Edit command. 

 

Note: If the symbol (-) appears in front of a sketch in the Operations/Entities tree, it means that the sketch is 
underconstrained. 

• Right-click on the 18mm dimension and select the  Deactivate command. The dimension is in brackets; it is 
no longer driving but just informative.  
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• Add a coincidence constraint to position the segment as shown below. To do this,  drag the segment onto 
the edge of the post. 

  

• Confirm the sketch by double-clicking with the right mouse button in the graphics area without active selection. 

You will notice that the BarHeight parameter has been automatically adjusted. 

•  Save the Railing assembly document. 
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Bill of materials of the railing and identification 

General bill of materials 

This bill of materials allows you to have a global and tree view of the assembly. It is useful for viewing the different 
sub-assemblies and their constituents. 

• Right-click on the Railing assembly document's tab and select the  Bill of Material command. 

• Select the Multi-level template from the Steel Standard Templates - United States folder and click on  to 
confirm the operation. 

• Click on  to confirm the Assembly dialog box that appears. 

• Rename the following parts: 

- Filling left side 

 

- Left plate 

 

- Right plate 
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When renaming, TopSolid reorganized the bill of materials by applying a sorting to the designation (default sorting). 
As a result, the bill of materials frames are no longer in order. 

 

• To reinitialize the indexes, select the  Reinitialize Bill of Material Indexes command from the Bill of 
Material tab. 

•  Save the bill of materials. 
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Bill of materials for identification by manufacturing index 

In order to facilitate the production of a work, you have to identify the parts and assemblies to be produced. In the 
interest of optimization, it is necessary to group identical parts and assemblies as much as possible in order to avoid 
creating similar production documents. 

• Right-click on the Railing assembly document's tab and select the  Bill of Material command. 

• Select the Part-Flat template from the Steel Standard Templates - United States folder, then click on  to 
confirm. 

The assemblies are ignored and all the parts are regrouped. This is possible thanks to the four display modes 
available at the top right of the screen. 

 

Here is a comparison of the four display modes: 

Top level 
 

 

Corresponds to the highest level. 
The detail of the sub-assemblies 
is not displayed. 

Multi-
level 

 

 

Provides a hierarchy view of the 
assembly. 

Flat 

 

 

This is the lowest level. 
The intermediate assemblies are 
hidden. This is the ideal mode to 
create cutting rates. 

Assembly 
Only 

 

 

Only the assemblies are kept 
without hierarchical distinction. 

To calculate its groupings, TopSolid uses two elements by default: 

- the properties used as the columns in the bill of materials; 
- the geometry of the part. 

Note: You can delete these criteria by editing the BOM operation and unchecking the Compare parts geometry 
and Groups by properties boxes. 
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Properties have a secondary role; they make it possible to order the list of parts to be indexed. 

The default sorting is as follows: 

- Part number 
- Manufacturer 
- Manufacturer part number 
- Material 
- Thickness 
- Length 

As for the multi-levels bill of materials, the indexes are calculated. We will use these indexes to identify our parts 
by returning them to the assembly. 

• From the Bill of Material tab, select the  Manufacturing Index command. 

At this stage, TopSolid copies the indexes on the different occurrences of the assembly, by adding a property named 
Manufacturing Index to each of them. This property is visible on each occurrence in the Parts folder of the assembly 
document's Entities tree. 

 

The manufacturing index are updated manually by relaunching the command. You can delete them by using the 

 Clear Manufacturing Index command in the Bill of Material tab. 

To summarize: 

- Once the assembly is completed, create a Parts – Flat bill of materials. 

- Select the  Manufacturing Index command. 
- The assembly is automatically updated with all the manufacturing indexes. 
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Now let us move on to identifying the assemblies. 

• Right-click on the Railing assembly document's tab and select the  Bill of Material command. 

• Select the Assemblies-Flat template from the Steel Standard Templates - United States folder, then click on 

 to confirm. 

Warning: The geometric comparator only works for the parts. For the assemblies, TopSolid is based on the priorities 
used in the BOM. 

This BOM has a default index rule which can be edited using the  Index Rules command. 

• From the Bill of Material tab, select the  Manufacturing Index command. 
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Cutting sheets 

The cards are automatic drawings made up of a title block and a schedule. These are documents ready to be printed. 

Extruded bar cutting sheets 

• Right-click on the Railing assembly document's tab and select the  Drafting command. 

• In the Steel Standard Templates - United States folder, open the Sheets sub-folder, select the A4 extruded bar 

cutting sheet template, then click on  to confirm the operation. 

 

Note: The document template to create the extruded bars includes the symbolization of the cuts. The upper symbol 
(on the left in the bill of materials) represents the front view of the extruded bar. This is the great height for 
rectangular tubes, IPE, etc. 
The second symbol represents the top view. 

|: no cutting 
[: cutting on another plane 
/: positive cutting 
\: negative cutting 
*: disoriented cutting 
/ ! \: symbol calculation problem  
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Example: 

Angle 1: 43.5° 
Angle 2: 0.9° 
Symbol: /--] [--/ 
Extruded bar: 

 

Here is the orientation of the main extruded bars in relation to the two symbols. 

 

•  Save the drafting document. 
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Sheetmetal sheet 

• Right-click on the Railing assembly document's tab and select the  Drafting command. 

• In the Steel Standard Templates - United States folder, open the Sheets sub-folder, select the A4 extruded bar 

cutting sheet template, then click on  to confirm the operation. 

 

Note: This sheet can be printed directly. To do this, you simply have to select the  Print command in the system 
toolbar at the top left of the screen. 

•  Save the drafting document.  
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Railing drafting 

 

• Right-click on the Railing assembly document's tab and select the  Drafting command. 

• Select the Assembly A3 ISO Landscape template from the Steel Standard Templates - United States folder. 

TopSolid prompts you to select a reference BOM. 

• Select the Railing – Multi-level bill of materials. 

 

• Rotate the view so that it faces the left side. To do this, click on the sphere as shown below. 
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• Add the top view, then the isometric view. 

 

• Reposition the isometric view at the bottom right and switch to shading render mode. 

 

As you can see, the railing has kept its inclination due to the slope. We are going to reorient it correctly in 3D. 
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• Return to the Railing assembly document. 

• Right-click on the sheet metal as shown below and select the  View Along Normal command. 

 

• Right-click on one of the rails and select the  View Horizontally command. 

 
  



TopSolid’Steel - Basics  Part 2 - In-Place Design of the Railing 

TopSolid   115 

• From the Entities tree, open the Cameras folder. 

• Right-click on Left Camera and select the Define From View command. 

 

• Click on  to confirm the dialog box. 

•  Save the assembly document. 
 

• Return to the drafting document and edit the first view. 

 

• Select Left camera from the drop-down list. 

 

• Click on  to confirm the operation. All of the views reposition themselves. 

Warning: If the angle of the balcony changes, you will have to repeat this action because the angle of the railing 
will also change.  
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• From the View tab, select the  View along a Direction command. 

• Select the top view as the reference view and select an edge of the plate or post as the direction. 

• Select the Parallel option. 

• Click on the  icon to move to the next step. 

 

• In the  Advanced Options dialog box, check the Set view upright box. 
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• Position the view as shown below. Click on the red padlock under the view if necessary. If the view is not straight 
while positioning, it will be set upright when the command is confirmed. 

 

• Click on  to confirm the operation. 

• Right-click on the previously created isometric view and select the  Alignment command. 

• In the Reference View section, select the first positioned view (left camera). 

 

• Click on  to confirm the operation. 
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• From the Detailing tab, select the  Composite Dimension command. Select the  Cumulative mode and 
the Horizontal direction. Select the first post on the left as the origin geometry and select the second and last 
posts as the measure geometries. 

 

• Click on  to confirm the operation. 

You will notice that the railing is alone. This allows you to set the dimensions of the work without loading the 
drawing with the environment. However, it is possible to create 2D outlines to facilitate the understanding of the 
set. 

• Right-click on the view as shown below and select the  Edit Detailing command. 

 

TopSolid switches to the sketch context directly at the view's scale. 
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• Draw the following sketch. 

 

• From the Sketch tab, select the  Section command. 

 

• Select the two previously created rectangles and select the Concrete type. 
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• Confirm the sketch by double-clicking with the right mouse button in the graphics area without active selection. 

To make the result more aesthetic, you can hide excess lines. 

• Right-click on the view and select the  Geometries Attributes command. 

• Select the lines as shown below and select the Hidden line category. 

 

• Click on  to confirm the operation again. 
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We saw previously how to add an automatic indexing. You can manually add interesting indexes on different views. 

• From the Detailing tab, select the  Bill of materials Index command. 

• Select the QtyDesc_MatCoatMass style and add some indexes. 

 

•  Save the drafting document. 
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Reassembly of the environment and the railing 

We have just created the railing drafting document without its environment. In order to be able to create a layout 
drafting of both, you have to assemble the railing with its balcony in a new assembly document. 

• From the Project tree, right-click on the project name and select the  Assembly command. 

• Right-click on the assembly document you have just created and select the  Properties command. 

• Enter Railing + Balcony in the description field. 

• Make sure that the Balcony and Railing documents are open. 

• From the Assembly tab, select the  Inclusion command. 

• Select the Balcony document. Make sure that the Inclusion at origin box is checked and then click on  to 
confirm the operation. 

• Select the  Inclusion command again. 

• Select the Railing document. Make sure that the Inclusion at origin box is checked and then click on  to 
confirm the operation. 

The railing is positioned in the right place, but it is still necessary to add positioning constraints. 

• Exit the Constraint dialog box. 

• Still in the positioning context, right-click on the railing and select the  Fix command. 

 

The railing is displayed in gray. The positioning operation is complete. 

• Confirm the positioning context. 

•  Save the Railing + Balcony assembly document. 
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Complete stage drafting 

• Right-click on the Railing + Balcony assembly document's tab and select the  Drafting command. 

• Select the Assembly A3 ISO Landscape template from the Steel Standard Templates - United States folder. 

• Position the views as shown below. 

 

• Right-click in the graphics area and select the  Scale command. 

• Enter 1/20 and click on  to confirm the operation. 

• Right-click on the isometric view and select the  Edit command. Modify the relative scale of the view by 

entering a scale factor of 0.7 and click on  to confirm the operation. 

 

Note: This scale factor will be added to that of the drawing. 

•  Save the drafting document. 
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• From the Project tree, right-click on the Railing + Balcony drafting document and select the Import/Export > 

 Export Document with Conversion command. 

• Select the desktop as the destination and select the Acrobat PDF3D (*.pdf) format. 

• Click on OK if TopSolid asks you to calculate the projection. 

• Select the view as shown below. 

 

• Click on  to confirm the operation. 

Note: When exporting PDF, you can adjust the line thicknesses directly via the Tools > Options > Translators > Pdf 
3D command. 

• From the desktop, open the generated PDF document. 

Adobe normally displays a message indicating that the 3D content is disabled. 

• Select the Edit > Preferences > 3D and Multimedia command. 

• Check the Enable playing of 3D content box, then click on OK to confirm. 

You can now modify the isometric view. 

 

 or  hold down Zoom 

 hold down Rotation 

 hold down +  hold down Dragging 
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Note: You can export an assembly or a part directly as a 3D PDF without using a drafting document. To do this, you 

simply have to right-click on the part or assembly and select the Import/Export >  Export Document with 
Conversion command. 

• In the Project tree, create a new folder Railing and drag all of the created documents into it. 

 

• Right-click on the Railing folder and select the  Check In command. 

• Click on  to confirm the check-in operation. 
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Conclusion 

We have just used two very different design methods, each with its advantages and disadvantages. 

Reminder: 

- Reassembly design (bottom-up): 

 

- In-place design (top-down) 

 

Overall, the reassembly design is useful to create the company’s standards or to split a design into several 
independent or weakly linked assemblies. 
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This cutting can be geographical or functional. 

Here is a sample splitting: 

 

Each assembly represents an existing in place design that was then integrated into an overall assembly. All areas 
can be worked on independently while keeping a link with civil engineering: their background document. A 
modification of the latter will result in the updating of each of the sub-assemblies.  
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Part 3 - Introduction to the Parameterization with the Stair 

We have seen that TopSolid integrates a certain number of automatisms with regard to repetition patterns (railing 
posts, bars, etc.). In addition, the parameterization can be used to manage more complex cases according to your 
design rules. 

The following exercise serves as an introduction to the parameterization which can be supplemented with other 
training courses. 

 

Concepts addressed: 

- Creating the parameters 
- Creating relationships between parameters 
- Using parameters to design 
- Integrating standard components (screws) 
- Understanding the concepts of process and assistant 

Creating the basic parameters 

• From the Project tree, right-click on the project name and select the  Assembly command. 

• Rename the assembly document Right stair. 

• From the Entities tree, right-click on the Parameters folder and select the  Real Parameter command. 

The real parameters are the most common parameters. They can be of any type (length, angle, without unit, 
surface, etc.) and can integrate formulas themselves. For more experienced users, it is possible to integrate VB.net 
or C# scripts. 

• Select Length as the type, enter Height as the name and a value of 2500mm. 

 

•  Pin the command’s dialog box and click on  to confirm the operation. 
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• Create the TotalRunMax and UnitRiseMax parameters as shown below. 

  

We will now move on to the calculation section. 

• Create a new  real parameter. 

• Select the Factor type. This is a type without unit, ideal for entering quantities. 

Note: Entering the Height/UnitRiseMax value is one solution but not the best because the result will contain 
decimals. TopSolid will round off to the nearest number when we do the repetitions. 

TopSolid is capable of managing three types of rounding: 

Name Operation Formula Result 

 Without rounding Height/UnitRiseMax 13.16 

Floor Less than Floor (Height/UnitRiseMax) 13 

Round Nearest Round (Height/UnitRiseMax) 13 

Ceil More than Ceil (Height/UnitRiseMax) 14 

In this case, we will use the Ceil formula since the rise height is a maximum value. 

• Enter the following values. 

 

When you enter the name of a parameter, TopSolid offers the list of parameters already created. You can navigate 
through this list using the mouse or the up and down keys on the keyboard. Once the parameter is selected, you 
simply have to press the Tab key to enter the name of the parameter. 

• Click on  to confirm the operation.  
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Note: You can resize the dialog box by  dragging the right edge. 

• Create a new RealUnitRise parameter using the Length type. 

 

• Create a new RealUnitRun parameter using the Length type. 

 

The basic parameterization is complete by now. This is not the ultimate rule for calculating a right stair, it is just a 
rule. The advantage is that you are able to configure according to your know-how, as well as your work habits and 
work constraints. 

We will add verification parameters, but this step is not mandatory. 

• Create the UnitPitchDistance parameter using the Length type. 
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• From the Entities tree, right-click on the Parameters folder and select the  Boolean Parameter command. 

• Enter the name parameter BlondelTest and the following formula. 

 

Note: The following symbols can be used: 

- &&: AND 
- ||: OR 

• Click on  to confirm the operation. 

The value is wrong, which means that the stair does not comply with Blondel's formula. 

• Edit the UnitRiseMax parameter, enter a value of 200mm and then click on  to confirm the operation. 

All the parameters are recalculated and the unit pitch distance is now correct. 

Summary of common parameters in TopSolid 

Icon Description 
Default 

unit 
Use 

 Real Parameter 
M², °, 

mm, u, 
etc. 

The most common parameter that allows you to define and 
calculate with a large number of value types (area, angle, length, 

factor, etc.). 

 Angle Parameter ° 
Measures the angle between two directions. This angle can be 

used in a command or a formula. 

 Distance Parameter mm 
Measures the distance between two entities. This distance can be 

used in a command or a formula.  

 Length Parameter mm 
Measures the length of a profile. This profile can be a sketch or 

directly an edge or a set of edges on a shape. 

 Boolean Parameter None 

Parameter whose value is True or False. Ideal for asking a question 
with a "Yes/No" answer, for managing options and variants ("Last 

rise?", “Bars?"). 
Can be used directly to enable/disable operations via conditions. 

 Integer Parameter None 
Parameter without decimal point or unit. This parameter can be 

used to define quantities, for example. 

 Text Parameter None 
As the name suggests, this parameter contains text. This text can 

be used in properties or formulas (text concatenations, etc.). 

  



Part 3 - Introduction to the Parameterization with the Stair  TopSolid’Steel - Basics 

132   TopSolid 

Creating the layout 

We will now draw the skeleton of the stair. 

• Right-click in the graphics area and select the  Sketch command. 

• Draw the following rectangle. 

 

• From the 2D Sketch tab, select the  Position Sketch command and select the absolute XZ plane as the 
support plane. This will allow the Z axis to be vertical. 

• Add the following dimension using the Height parameter as the value. 

 

TopSolid automatically retrieves the value of the parameter. 
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• Select the  Contour command and draw the segments as shown below. 

 

These segments represent the first step as well as the nose of the second step. 

• Add the following dimensions using the previously created parameters. 

 

The sketch should appear in blue to indicate that it is fully constrained. 

• Confirm the sketch. 

Creating the step 

The step will consist of two parts: 

- a wooden step; 
- a bent sheet metal step support. 

• Right-click on the layout sketch and select the  In Place Part command. 

Note: Using the sketch allows TopSolid to orient itself in the same way, thus avoiding the reorientation step. 

• Draw the sketch shown below using the  Rectangle command. 
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It is important to set the dimensions against the second step. Indeed, if the unit run changes, the step will be 
recalculated automatically. 

• Right-click in the graphics area with no active selection and select the  Extruded command. Enter a length 

of 1000mm and click on  to confirm the operation. 

 

• Right-click on the edge as shown below and select the  Fillet command. Enter a value of 15mm and click on 

 to confirm the operation. 

  

• Confirm the in-place editing context. 

We will now create the support. 

• Right-click on the layout sketch and select the  In Place Part command. 

• Draw the following sketch. 

• Add a  parallelism constraint between the treading and the highlighted segment as shown below. 
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• Right-click on the same segment and select the  Construction command. This command is used to indicate 
to TopSolid that this element is simply used to facilitate the construction. It will therefore not be taken into 
account when switching to 3D. 

 

• Right-click in the graphics area with no active selection and select the  Sheet Metal on Sketch command. 

• Enter a thickness of 3mm. 

• Right-click on the arrow in the graphics area and select Limit > Plane. 
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• Select the side face of the step as the plane. 

 

• Right-click in the graphics area with no active selection. Make sure the Bends box is checked and select the 
Thickness mode so that the bend is equal to the thickness of the sheet metal. 

 

• Click on  to confirm the operation. 

• Confirm the in-place editing context. 

•  Save the assembly document. 

Although the step support has been created in place, it has its own document, allowing you to work on it in isolation. 

• Right-click on the step support and select the  Open Document command. 

TopSolid opens the part in a new tab. 

• Refocus the camera on the step by double-clicking on the  mouse wheel. 

It is often easier to create the bent parts directly. It is sometimes necessary to unfold them to add the operations 
that occur before bending, such as the cutting operations. This is what we are going to create here by producing 
the cutting as shown below before bending. 
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• From the Sheet Metal tab, select the  Unbending of Bend command. 

• Select an edge of the horizontal section as the fixed edge and select the bend as the bend face. 

 

Note: Checking the All bends box would have been possible. 

• Click on  to confirm the operation. 

We will now draw the sketch that will be used for the cutting operation. To save time, we will work symmetrically. 

• Right-click on the top face as shown below and select the  Sketch command. 

• From the 2D Sketch tab, select the  Position Sketch command. 

• Select the edge as shown below as the origin point. 

 

• At the top right of the screen, click on the  Dynamic Symmetry icon. 

• Select the  Simple symmetry mode and select the Sketch OX Axis option. 

 

• Click on  to confirm the operation. 
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TopSolid will dynamically draw the reverse side. 

• Draw the sketch shown below using the  Line command. 

 

Note: If a line has to pass through the symmetry, you simply have to make it touch the axis of symmetry. 

• Draw the line as shown below. 
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• Select the  Arc command. Make sure that the Free size mode is selected and that the Given center box is 
unchecked. 

• Draw the first arc as shown below. 

 

• Draw the second arc as shown below. 

 

• Delete the radius dimensions on both arcs. 

• Add the dimension as shown below on the left arc. 
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• Add a coincidence constraint on the center of the right arc. 

 

• Right-click in the graphics area with no active selection and select the  Trim by Profile command. The yellow 
arrow indicates the position of the waste part; in our case, it should point outward. If this is not the case, 
double-click on the yellow arrow. 

 

• Click on  to confirm the operation. 

• From the Sheet Metal tab, select the  Rebending of Bend command. 

• Select an edge of the horizontal section as the fixed edge and check the All flat bends box. 

 

• Click on  to confirm the operation. 
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• Right-click on the edge as shown below and select the  Angle Relief command. 

• Select the Fillets mode and enter a radius of 500mm. 

 

• Click on  to confirm the operation. 

•  Save the part document. 
 

• Return to the Right stair assembly document. 

You will notice that the step has been updated. 

 

The entire step could have been created completely independently, as was the case with the railing post. The 
advantage is that it could have been reused on another stair. 
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Creating the repetition 

We will now create the step and its support. 

• From the Construction tab, select the  Repetition command. 

• Select the step and its support as the entities to be repeated. 

• In the Pattern field, click on the  icon and select  Profile Pattern. 

• Select the treading as the profile. To do this, use the rotary picking technique to avoid selecting the entire 
triangle. 

• Check the Origin point box and select the nose of the first step. 

 

• Check the Total count box and select the StepNumber parameter. Select Distance as the spacing type, uncheck 
the Spacing distance box, then select a Constant orientation type. 

 

Note: This pattern is very practical because, in addition to being able to work with a quantity, we could have simply 
used the step height or the tread. 

• Click on  to confirm the pattern, and then the repetition.  
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Creating the stringers 

• Right-click on the treading segment and select the  Extruded bar command. 

• Select the UPN Beam 100, NF A 45-202 family and the 100 code. 

• Invert the reference direction. 

• Enter an orientation of 90° to position the U outward, then select the top left positioning point. 

• Enter a vertical shift of 150mm. 
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• Right-click on the extruded bar and select the  Planar Trim command. 

• Select Absolute XY plane from the drop-down list and enter an offset of 10mm. 

 

• Click on  to confirm the operation. 

• Repeat the operation on the top part of the stringer by selecting the back face of the landing step. 

 

• Perform a final planar trim with the top face of the landing step. Make sure to adjust the offset value to 0mm. 
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Creating the plates 

Down plate 

 

• Right-click on the following face and select the  In Place Part command. 

 

• Enable the  Cut mode at the top right of the screen. 

• Draw the sketch as shown below. 

 

• Right-click in the graphics area with no active selection and select the  Sheet Metal on Sketch command. 

• Orient the part downward and enter a thickness of 10mm. 

 

• Click on  to confirm the operation. 
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• Create a new sketch on the top face of the plate. 

• Select the  Offset command. 

• Select the contour of the plate, enter a distance of 20mm and orient it inward. 

 

• Click on  to confirm the operation. 

• Right-click in the graphics area with no active selection and select the  Vertices not internal command. 

 

This command makes all the vertices of the sketch available outside of the sketch. You can modify this state locally 

on one or more vertices by selecting the  Internal or  Not Internal command via the contextual menu. 
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• Right-click in the graphics area with no active selection and select the  Drilling Group command. TopSolid 
positions a drilling on each vertex declared as not internal. 

• Enter a diameter of 13mm. 

 

• Click on  to confirm the operation. 

• Right-click on one of the angles and select the  Angle Relief command. 

• Select the Chamfers mode, enter an offset of 10mm and select the other three angles. 

 

• Click on  to confirm the operation. 

• Confirm the in-place editing context. 
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Upper plate 

On the upper part of the stringer, we will now add the plate as shown below with its drillings. 

 

• To do this, create a new  in-place part. 

• Create a  sheet metal on sketch with a thickness of 10mm. 

• Create the above sketch with non-internal vertices. 

• Create a  drilling group. 

• Confirm the in-place editing context. 

You will then notice the disparaging detail as shown below. 

 

• Right-click on the section of the extruded bar and select the  Edit command. 

• Add an offset of 5mm. 
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The extruded bar and the plate should normally have an offset of 5mm. If this is not the case for the plate, you have 
to modify the sketch of the plate. 

 

• Create a new in-place part with a sheet metal sketch with a thickness of 5mm. 

 

• Confirm the in-place editing context. 

• From the Modeling tab, select the  Trim command in the assembly document. 

• Select the previously created part. Select the Plane mode and select the top face of the UPN beam. Uncheck 
the Straighten lateral faces box in the advanced options. 

• Make sure to point the yellow arrow toward the waste part. 
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Symmetry management 

We will now look at symmetry management. Firstly, it is important to distinguish between the mirrored part and 
the symmetrical part. Here are a few examples: 

 

1 symmetry plane 
Symmetrical part 

 

1 symmetry plane 
Symmetrical part 

 

3 symmetry plane 
Symmetrical part 

 

0 symmetry plane 
Mirrored part 

All the symmetrical parts can therefore be positioned on the right side of the stair by simply turning them over. The 
stringer will have to have a mirrored part. We will start with the latter. 

Mirrored part 

• From the Construction tab, select the  Repetition command. Select the stringer as the entities to be 

repeated. In the Pattern field, select  Symmetrical Pattern. 

• Select Plane as the type of symmetry. In the Plane field, click on the  icon and select  Midplane. Select 
the two side planes of the step. 

 

• Click on  to confirm the operation. 
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• In the Transforms type field, select Symmetry from the drop-down list. 

 

• Click on  to confirm the pattern. 

• Click on  to confirm the repetition. 

The following message appears. 

 

• Click on OK. 

TopSolid prompts you to select a document template for the mirror document. In this case, it is an extruded bar. It 
is therefore necessary to use the Part - 0mm (Extruded bar, Derivation, Mirror, Partial part) template. In case of a 
wrong choice, TopSolid will be in error when saving the document. 

 

• Click on  to confirm the operation. 

For the plates, we will see three alternative solutions. 

  



Part 3 - Introduction to the Parameterization with the Stair  TopSolid’Steel - Basics 

152   TopSolid 

Part with declared symmetry 

• Double-click on the down plate to edit it. 

• From the Tools tab, select the Symmetries >  Plane Symmetry command. 

• Click on the  icon and select  Midplane. 

• Select the planes as shown below. 

 

• Click on  to confirm the midplane. 

• Click on  to confirm the symmetry. 

• Confirm the in-place editing context. 

• From the Construction tab, select the  Repetition command. 

• Select the down plate as the entities to be repeated. 

• In the Pattern field, click on the mirrored stringer. 

 

• Click on  to confirm the repetition. 

This solution takes the longest to set up but the quickest to use. It is therefore ideal for standard parts or those 
parts that are most likely to be reused. 
Declaring symmetry also works on assemblies. 
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Symmetry by rotation 

• From the Construction tab, select the  Repetition command. 

• Select the up plate as the entities to be repeated. 

• In the Pattern field, select  Symmetrical Pattern. 

• Select the previously created plane. 

 

• Select Rotation as the transforms type. 

• Select a point in the middle of the thickness as the translations origin and select the Z axis as the rotations 
direction. 

 

• Click on  to confirm the pattern. 

• Click on  to confirm the repetition. 
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Here is what TopSolid does: 

 

Symmetry of the point with respect to the plane 

Rotation of the plate with respect to the point 
(translations origin) and in the direction of the 

selected rotations 

 

 

Result 

Symmetry by translation 

• From the Construction tab, select the  Repetition command. 

• Select the last upper plate as the entities to be repeated. 

• In the Pattern field, select  Symmetrical Pattern. 

• Select the previously created plane. 

 

• Select Translation as the transforms type. Select a point in the middle of the plate as the translations origin. 
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As with rotation, TopSolid symmetrizes this point. It will then measure the distance between the points and apply 
this value to the plate. 

• Click on  to confirm the pattern. 

• Click on  to confirm the repetition. 

Using screw components 

TopSolid is delivered with numerous fixing elements (screws, nuts, washers, etc.) in several different standards 
(ISO, AFNOR, DIN, etc.). Here we will see how to use them. 

The idea is to create a sketch that will symbolize the position of the different screws, place a screw and finally repeat 
it on the sketch. The advantage is that if the step dimensions change, the screws will reposition themselves 
correctly. 

• From the Visualization tab, select the  Cut by planes command. 

• Select the top face of the plate as shown below. 

 

• Double-click on the yellow arrow in the graphics area to invert the direction, then  drag the arrow upward to 
add an offset of -55mm. 

 

• Click on  to confirm the operation. 
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Note: The cuts are visible in the Entities tree. You can edit them from the tree, using the icons at the top right or 
directly via the contextual menu (without active selection). 

 

• Right-click on the following face and select the  Sketch command. 

 

• Draw the following rectangle. 
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• Right-click on the left vertical segment and select the  Create Middle command. 

 

• Right-click in the graphics area with no active selection and select the  Vertices not internal command. 

• Confirm the sketch. 

We will now search for a screw. 

• At the top right of the screen, select the  Quick Search command. 

• Adjust the settings as shown below. 

 

• Run the search by clicking on the  icon. TopSolid displays the following search results. 

 

• Close the quick search dialog box. 
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Note: You can lock the search results dialog box in the open state by clicking on the pin at the top right of the 
screen. 

• Include the Cross Recessed Countersunk Head Screw ISO 7046. To do this, click on the screw line and  drag 
it into the graphics area. 

The positioning wizard is displayed. 

• Select the Screw Automatic Buried Head wizard and the M4 x 25 size. 

 

As for drillings, TopSolid dynamically positions the screw based on the nearest edges. 

 

It could have worked, but that is not what we want here. We would like to hook on to the sketch. 
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• In the Frame field, click on the  icon and select the  Frame on Plane. 

• Select the face of the sketch as the OXY plane, select the Projected point mode, and then select the point of 
the sketch as shown below. 

 

• Click on  to confirm the frame. 

• Click on  to confirm the wizard. 

TopSolid then proposes to create the process associated with the screw. A process is a set of operations related to 
the component, in this case the screw. It can be a drilling, countersinking, tapping, cutting, etc. 

• Select the Tapped Hole process.  

TopSolid uses the ISO standard to dimension the various operations. The values can nevertheless be forced in the 
lower part of the dialog box. 

 

• Click on  to confirm the process. 



Part 3 - Introduction to the Parameterization with the Stair  TopSolid’Steel - Basics 

160   TopSolid 

The drilling, countersinking and tapping are created. 

 

The process is linked to the screw. If we move, delete, repeat or modify (diameter change) the screw, the process 
will be impacted. 

The Operations tree displays two very distinct operations. The first Wizard operation corresponds to positioning 
and the second Process operation corresponds to the associated machining. 

 

• From the Construction tab, select the  Repetition command. 

• Select the screw as the entities to be repeated. 

• In the Pattern field, select  Sketch Pattern. 

• Select the sketch as shown below and select the frame that was used to position the screw as the reference 
point. 

 

• Click on  to confirm the pattern. 

• Click on  to confirm the repetition. 
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As for the inclusion of the screw, the repetition was done in two steps, one for the screw and one for the process. 

 

• From the Construction tab, select the  Repetition command. 

• In the Repetitions field, select the repetition of the screw. 

• Check the Include original instance box. 

• In the Pattern field, select one of the repeated steps. 

 

Note: Using the Repetitions field instead of the Entities field allows you to manage the case where the number of 
screws changes. 

• Click on  to confirm the repetition. 

• From the Operations tree, right-click on the sketch that was used for the repetition of the screws (normally 

sketch 2) and select the  Edit command. 
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• Using the  Point command, add the point as shown below, then constrain it. 

 

Note: By default, the points created with the  Point command are not internal. 

• Confirm the sketch. 

The set is updated with the addition of the screw, the process, the repetition of the screws and the repetition on 
all the steps. 

• Right-click in the graphics area with no active selection and select the  Deactivate cut command. 

We will now make sure that the entire construction is well done. 

• From the Entities tree, adjust the value of the TotalRunMax parameter to 3500mm and that of the UnitRiseMax 
parameter to 180mm.  

The entire stair must be recalculated without any problems. 

 ➔  
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Creating the stringer sub-assemblies (in-place assemblies) 

• From the Modeling tab, select the  In Place Assembly command. 

• Select all the parts constituting the left stringer. To make the selection easier and make sure you do not forget 
anything, check the Hide box. 

 

• Click on  to confirm the operation. 

• Repeat the operation on the right side. 

•  Save the assembly document. 

Whenever possible, it is important to create the sub-assemblies at the end of the study. Indeed, adding an 
intermediate assembly hides part of the context. For example, on an extruded bar, it will no longer be possible to 
edit a section. In the Operations tree, you will need to move the cursor before creating the assembly in place. 

Bill of Materials 

• Right-click on the Right stair assembly document's tab and select the  Bill of Material command. 

• Select the Multi-level template from the Steel Standard Templates - United States folder and click on  to 
confirm the operation. 

• Make sure that the Groups by properties box is checked and click on  to confirm the operation. 
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Here is an example of one of the disadvantages of regrouping. The two stringers have been merged although they 
are two separate assemblies. As they have strictly the same properties, TopSolid therefore considers that they can 
be regrouped. 

• Right-click on the Assembly line and select the  Show in project tree command. TopSolid selects the 
assembly in the Project tree. 

• Right-click on the assembly document and select the  Properties command. Enter Left Stringer in the 

Designation field and click on  to confirm the operation. 

 

The left and right stringers are separated. 

• Rename the second sub-assembly Right Stringer, then rename the remaining parts as you wish. 

•  Reinitialize the Bill of Material Indexes. 

 

• Right-click in the Material column of the Step line and select Edit material and Coating. 

• Select the Wood category and the Oak material. 

•  Save the bill of materials. 

• From the Project tree, create a folder named Right Stair and then place the bill of materials and the assembly 
documents in it. 

•  Check the entire folder into the vault.  



TopSolid’Steel - Basics  Part 4 - PDM 

TopSolid   165 

Part 4 - PDM 

Some reminders 

Backups 

We saw previously that TopSolid automatically manages the backups and that it is possible to restore an earlier 
version at any time. 

 

Two backups are kept by default. To adjust the number of backups, you simply have to select the Tools > Options > 
PDM > PDM command and adjust the value in the Number of backups without back references to keep field. 

Check in 

We then saw that in order to benefit from the revision system and make the documents available to users, you 
have to check them into the vault. To do this, you simply have to right-click on a document, folder or project and 

select the  Check In command. 

This time the backups are deleted and the  icon is displayed in front of the document names. 

 

With each modification, TopSolid automatically updates the appropriate documents, exits the vault (the  icon 

has disappeared and has been replaced by this  icon) and increments the minor revision (A1, A2, A3, etc.). 

It is important to check documents regularly into the vault. 

Validation (life cycle) 

The validation option allows you to use the concept of life cycle. 

It is often used when the document is going to be distributed in another department, a subcontractor or when the 
project completes an important phase (study milestone, launch in manufacturing, end of project, etc.) or creating 
company’s standards. 

In general, changes are much less frequent than for checking documents into the vault. 
After validation, updates are not automatic. It is up to the user to choose whether or not to update his document 
through reference redirection. If it works, TopSolid will increment the major revision (B, C, D, etc.). 
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Deletion 

Deletion cycles were also discussed. If the documents are not in the vault, you simply have to delete them using 

the Delete key or via the contextual menu >  Delete). 

The documents are therefore placed in recycle bin of the project. 

You can then empty the recycle bin if and only if the documents are not used elsewhere. 

 

You can restore one or more documents deleted by mistake by right-clicking on the appropriate document(s) and 

selecting the  Restore command. 

Note: If the documents are in the vault, you will also need to put the deleted items into the vault so that they can 
go into the recycle bin. Before this last operation, the documents will still be in the project but simply crossed out. 

 

You can undo this deletion by right-clicking on the appropriate document(s) and selecting the  Undo changes 
command. 
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Purging the project 

As we have seen previously, TopSolid automatically creates backups, minor revisions, major revisions and 
documents in the recycle bin. At the end of the project, it is advisable to perform a purge which will delete all the 
unnecessary elements. 

• Right-click on My first project and select the  Check In command. 

• Update the indicated documents if necessary. 

• Right-click on My first project and select the Deletion >  Purge Project command. 

• Adjust the dialog box as shown below. 

 

• Click on  to confirm the operation. 

TopSolid indicates the number of deleted files as well as the space gained. 
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Import/export of a package 

Imports/exports are used to transfer documents (customer/supplier, mobile station) from one PDM to another. 
You can perform an export on each document, folder or project. TopSolid automatically exports all the documents 
required for the project. 

Exporting a project 

• Using the Ctrl key, select the Right Stair, Railing and Post + Plate folders, then right-click on one of the folders 

to select the Import/Export >  Export Package command. 

TopSolid takes an inventory of everything it needs to export in order to import the file correctly. It also makes sure 
that everything is up to date and in the vault. 

 

• Click on  to confirm the operation. 

• Place the package on the desktop. 

Let us say that you have been working on your project from another computer and now you want to reintegrate it 
into your computer. TopSolid offers two modes of operation: 

- import in replication: TopSolid makes sure that the project has not been modified and updates it. 
- import in copy: TopSolid creates a copy in a project. 

Note: You can also export the My First Project. Everything in the project will be exported. 
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Import in replication 

• From the Home tab, select the  Import Project command. 

• Select the previously created package and click on  to confirm the operation. 

 

TopSolid detects that there has been no modification of the project and therefore offers to make a copy. 

• Click on Yes. 

If the project had been modified, the project would have been updated. 
For this to work, at the time of export, it is imperative to make sure that the documents are up to date and are in 
the vault. 

Import in copy 

Following the previous operation, a new project is created (not in the vault). It is strictly identical to the original 
project. 

• Rename this project My first project V2. 

• Delete the Right Stair, Railing and Post + Plate folders in the project. 

• Create a new folder named Local Import. 

• Right-click on the folder and select the Import/Export >  Import Package command. 

• Select the previously created package. 

All the documents are copied and regrouped in the folder. 

 

To make a copy as we have just done, at the time of export, the documents do not have to be in the vault. 

• Close the My first project V2 by clicking on the project’s tab with the  mouse wheel. 
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Import/export with conversion 

Multiple DXF export 

• In the Post + Plate folder, right-click on the Draftings folder and select the Import/Export >  Export several 
Documents with Conversion command. 

• Select the desktop as the export path and select Name.Major.Minor.Extension from the Naming convention 
drop-down list. Select the AutoCad translator. 

 

• Click on  to confirm the operation. 

TopSolid highlights in green the documents that have been successfully exported. 

• Close the dialog box. 

Importing a step 

Numerous websites provide access to several manufacturers' catalogues in various industries. 

Here are a few of them, building oriented: 

BIMcatalogs.net (Cadenas) 
https://bimcatalogs.partcommunity.com/3d-cad-models/  
 
BIM&CO (TraceParts) 
https://www.bimandco.com/fr/objets-bim 
 
BIMObject 
https://bimobject.com/fr/product  
 
Polantis 
https://www.polantis.com/fr/ 

Without forgetting the industry leaders, Cadenas and TraceParts, which have a direct interface in TopSolid (File > 
Translators).  

https://bimcatalogs.partcommunity.com/3d-cad-models/
https://www.bimandco.com/fr/objets-bim
https://bimobject.com/fr/product
https://www.polantis.com/fr/
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• In the Project tree, create an Import Step folder, then right-click on this folder and select the Import/Export > 

 Import File with Conversion command. 

• Select the emile_maurin_92-951-48 file. 

• Click on  to confirm the import dialog box that is then displayed. 

 

TopSolid creates a new document. You can now rename it, assign a reference to it, a material, etc. 

Multiple printing configuration 

TopSolid allows you to automate printing (on physical printer or PDF) on an entire project. However, automation 
certainly involves a bit of parameterization beforehand. 

• From the Tools tab, select the  Options command. 

• Open the Printing node and select Multiple Printing Configuration. 

 

The upper table allows you to orientate the printings based on the format of the drafting. For example, A0 formats 
will automatically be sent to a plotter. 

The Printers Configuration section allows you to define the thicknesses when printing. 
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• In the Fallback printer field, select PDFCreator and then click on  to confirm the operation. 

Note: The alternative to using a virtual PDF printer is to directly use the TopSolid PDF export as seen in the Complete 
stage drafting section. 

• Right-click on the Post + Plate folder and select the Multiple Printing Configuration >  Print Several 
Draftings command. 

 

• In the Scaling section, select the In frame option. 

• Click on  to confirm the operation. 

• Click on Merge. This results in all the draftings being regrouped in a single PDF file. 
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The dialog box may vary from one version to another. 

• Click on Merge All, then click on Continue. 

 

• Select Save. 

 

PDFCreator offers many options such as the possibility to add watermarks, modify the format of the generated file, 
modify the PDF compression level, etc. 
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Annex: Customization 

Within the framework of the deployment of TopSolid, a customization/adaptation stage is necessary so that the 
product corresponds to the company's needs. We often see the following four stages: 

- Customizing document templates: 

o Drafting 
o Bill of materials 
o Unfolding 
o Part 
o Assembly 

- Creating a project template 
- Creating standard libraries regrouping elements common to business (materials, profiles, company’s 

standards, etc.) 
- Customizing the interface (icons, keyboard shortcuts, colors, etc.) 

We will cover almost all of these customization steps in this chapter, starting with document templates. 

Document templates 

Document templates can be stored in three different locations: 

- In the projects: The templates will only be accessible in the project where they are located. 
This is only recommended for basic documents such as parts, assemblies and possibly unfoldings. 
If a document is updated, remember to update it in all the projects where the update can be useful. 

- In My Templates: The templates will only be accessible by the user. For example, it is used in the case of a 
single-user installation (a TopSolid license in the company). These templates can be used in all projects by 
the user. 

- In Company Templates: These templates are centralized and can be used in all projects by all users. 

Summary: 

- In the projects/Templates of the project → Parts, assemblies and possibly unfoldings templates. 
- In My Templates/Company Templates → Bills of materials, draftings, drafting bundles templates, etc. 

My templates/Company templates 

Depending on the installation available in your company, it is advisable to use the right area for the following (My 
templates for single-user, Company templates for multi-user). 

• Click on the  TopSolid 7 icon and select the File > Document templates >  Open My Templates (or 
Company templates) command. 

• Right-click on My Templates (Documents) and select the  Folder command. 

• Create two folders named Draftings and Bill of Materials. 
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Customizing a drafting template 

We will now customize a drafting template in your company's colors starting from a template delivered as standard. 

• In the My Templates/Company Templates project, right-click on the Draftings folder and select the 

 Draftings command. 

• Select the Assembly A3 ISO Landscape template from the Steel Standard Templates - United States folder. 

A drafting has two stages of creation: 

- the background (creating the title block and the various parameters); 
- the drafting (positioning the different views). 

These stages can be seen here: 

 

• Select the background stage. 

• Edit the background logo. To do this, right-click on the logo and select the  Edit command. 

 

• Select your company logo. 

• Edit all the texts based on your company. To do this, right-click on the text and select the  Edit command. 
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• Right-click on the drawing’s frame and select the  Edit command. 

 

• In the Predefined format field, select A4 ISO Portrait. Uncheck Cutting tabs, Centering Marks, Orientation 

Marks and Graduations, then click on  to confirm the operation. 
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• From the Operations tree or the Entities tree, open the Parameters > Document Name Parameterization 
folders and edit the TemplateDraftingName parameter. 

• In the Value field, change Landscape to Portrait and click on to  confirm the operation. 

 

You can go further in the customization process using the styles options. The styles are specific to the document 
and exist in all types of document (part, assembly, drafting, etc.). They are directly available from the Entities tree. 

 

Let us imagine that we want to create a new index style containing the description of the part, its material and 
thickness. 

• Right-click on the Index Styles node and select the  Bom Index Style command. 

 

A new style is created. Each style has a base style (in this case, Normal). Checking an option in this dialog box means 
that you do not want to inherit the base style and therefore change it. 

• Check the Upper Text box and click on the Edit button. 

• Delete the word Index and click on the  Insert BOM Property icon. 
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• In the dialog box that appears, select Standard > General > Description and click on  to confirm the 
operation. 

 

• Check the Upper Text box and click on the Edit button. 

• Click on the  Insert BOM Property icon. 

• Select Standard > Dimension >Thickness and click on  to confirm the operation. 

• Click on  to confirm the Format dialog box that appears. 

• Using the Enter key, go to the next line to place the cursor under the Thickness text. 

• Click on the  Insert BOM Property icon. 

• Select Standard > Material >Material Description and click on  to confirm the operation. 

 

• In the Name field of the style dialog box, enter Desc_EpMat and click on  to confirm the operation. 

The new index style is finished. 
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When used, this style will give the following result. 

 

The customization of the drafting is complete. 

•  Save the drafting document, close it, then  check it into the vault. 

Customizing a BOM template 

We will now customize a BOM template by working on the columns, the sort order and the precision of the values. 

• In the My Templates/Company Templates project, right-click on the Bill of Materials folder and select the 

 Bill of Material command. 

• Select the Sheet Metal template from the Steel Standard Templates - United States folder. 

• Right-click on the HOLES NUMBER column and select Delete column. 

• Repeat the operation for the PERIMETER and SURFACE AREA columns. 

• To do this, right-click on the last column and select Add Column. Select Standard > Dimension > Mass. At the 

bottom of the dialog box, enter 1 in the Number of decimals field, then click on  to confirm the operation. 
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There is an advanced mode for editing the columns. 

• From the Bill of Material tab, select the  Columns command. 

A dialog box appears. On the left side of the screen you can see all the properties available in a bill of materials. You 
can add them to the bill of materials using the green arrow (a property must be selected to see it) or delete them 
using the red arrow. 

 

In the lower right frame, you will find the sort order. In this case, the sorting will be done first by material, then by 
thickness, by part number and finally by description. You can obviously change the sort order. 

• In the bottom right frame, select the Thickness property. A light blue arrow appears on the right. 

• Click on the arrow to move the property to the first position. 

 

In the dialog box, it is also possible to force the title of a column, to adjust the precision of the values, to modify the 
order, to force the width of a column, etc. 

• Click on  to confirm the operation. 

•  Save the bill of materials document, close it, then  check it into the vault. 
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Creating a project template 

We have previously seen how to create document templates (drafting and bill of materials). A similar approach 
exists for a complete project. 

You will have noticed throughout this training course that organizing documents in the project tree is important 
but repetitive. Therefore, it is advisable to integrate it when you are creating the project. This is what we will cover 
in the next exercise. 

• Create a new project by clicking on the  icon in the Home tab or by using the Ctrl + Shift + N keyboard 
shortcut. 

• Rename the project My project template, select Design Template in the Steel Templates folder, then click on 

 to confirm the operation. 

At the beginning of the training, we addressed the subject of references, which is an essential element allowing you 
to use or delete libraries in your project. 

A project that has too many references may overwhelm searches and the list of available extruded bars in the 

 Extruded bar command. 
Conversely, a project containing too few references will simply prevent you from accessing potentially useful 
components in your design. 

• From the Project tree, open the References node, right-click on the TopSolid DIN Mechanical library and select 

the  Delete command or press the Delete key directly on the keyboard. 

All the components in this library are now inaccessible in this project. 

• Right-click on the References node and select the  Reference Library command. 

• Using the Ctrl key, select the TopSolid ANSI Mechanical and TopSolid DIN Mechanical libraries and click on 

 to confirm the operation. 

Both libraries have been added to the references. 

• Right-click on the project name and create the following  folders: 

- Unfoldings 
- Draftings 
- Bills of materials 
- Parts 
- Stringers 

Note: This part is completely free and can be adapted according to your needs. 

The order is alphabetical in the Project tree. If you want to change the order, you simply have to add a number in 
front of the folder name (for example: 1 - Parts, 2 - Sub-assemblies, etc.). 

• Right-click on the project name and  check the entire project into the vault. 

• Add this project to the project templates. To do this, right-click on the project name and select the Others > 

 Add to Templates command. Depending on the installation available in your company, select My 
Templates or Company Templates. 

This project can now be selected when creating a new project. If you wish to upgrade it, you simply have to open 

the project manager by clicking on the  Projects icon in the Home tab and click on the  Show template 
projects icon. The project templates will be visible and editable just like any other TopSolid project. 
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Customizing the interface 

TopSolid's interface is very flexible. During the training course, we saw that trees can be placed anywhere on the 
screen, hidden, moved, etc. You can also display your favorite icons directly on the screen or to even add your own 
keyboard shortcuts. 
Finally, all of these parameters can be exported to be saved or installed on another machine. 

Menu creation 

• Open or return to My First Project. 

• Open or create a part (it does not matter what type). 

Each type of document has its own tabs, icons and shortcuts that are integrated into the menus. Customizing the 
interface is therefore done document type by document type. 

The first step is to create a new menu. 

• From the Tools tab, select the  Menu command. 

• Click on the Add button, enter the name Training and click on  twice to confirm the operation. 

• From the Tools tab, select the previously created Training menu as shown below. 

 

Adding shortcut icons and shortcut keys 

• From the Tools tab, select the  Customize command. 

A dialog box appears and red areas appear on the screen. These symbolize the areas where commands can be 
added or deleted. 

• From the Command Category drop-down menu, select Analysis and  drag the  Analyze Geometry 
command to the lower red area of the screen. 

 

To delete a command, you simply have to  drag it outside of an area. 

Note: The Add user context button allows you to add a tab at the top of the screen. This is very useful to create a 
group of commands that you can use regularly. 

• Click on the Shortcut keys tab, select the Analysis command category and select the  Analyze Geometry 
command.  
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• In the Press new shortcut keys field, click Alt + M. 

• Click on the Assign button to assign the keyboard shortcut. 

 

• Click on  to confirm the operation. 

Saving and importing the settings 

• From the Tools tab, select the  Manage Settings command. 

• Select the Export application settings option and click on the  Next icon. 

• Make sure that all the boxes are checked and then click on the  Next icon again. 

• Select a location to export the settings and possibly modify the default name. 

• Click on  to confirm the operation. 

The import is done via the same command, as well as reinitializing the settings. 
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Introduction to libraries 

TopSolid comes with a large number of standard element libraries. It is natural and advisable for a company to 
create its own libraries. 

Typically, several libraries are created to avoid confusion. Here is a client example of a few libraries: 

 

Here we will find company’s standard (railings, fixings), commercial elements (Schüco, Wurth), standard elements 
(extruded bars), as well as a Common library. 
The Common library regroups everything that will be common to libraries and projects. This can be filters (filtering 
of parts, assemblies according to several criteria), user properties (production mode, supply mode, sub-assembly 
type, etc.), functions, processes, etc. 

• Open the Library Manager by clicking on the  Libraries icon on the Home tab, then create a new library by 

clicking on the  New Library icon. 

 

• Rename the library My Company - Common and use a blank template. 

As you can see, a library is presented exactly like a project. Therefore, everything that was seen during this training 
course is applicable here. 

Warning: This new library can only be used in your projects if it is referenced. 

Using the unfolding rules for unfoldings 

Now that the user library has been created, we will include an unfolding rule for the sheet metal. To avoid starting 
from a blank page, we will use an unfolding rule provided by TopSolid as a basis. 

• Open the Library Manager by clicking on the  Libraries icon in the Home tab and open the TopSolid 
Mechanical library. 

• Open the Sheet Metal > Unfolding Rules folders and copy the Steel Tables document. 
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• In the My Company - Common library, create a new folder named Unfolding Rules and paste the previously 
copied steel table into it. 

 

Note: You cannot edit a component and more generally, a library provided by TopSolid. The libraries are locked for 
modification so that they can be updated if necessary. 
However, as you can see, they are not copy-protected. You can therefore copy or derive them according to your 
needs. 

• Rename the document Steel tables company and open it. 

 

There are two main methods of calculation: 

- Thickness/Angle couple: This is the current setting. The table reads from left to right: for a sheet metal 
thickness of 1.5mm, TopSolid will use a V of 10 by default which will produce a radius of 1.6mm. For a 30° 
angle, the correction will be -0.7mm. 

 

- Radius/Thickness ratio: Coefficients and a K factor are entered and for each of them. For example, for a 
radius/thickness ratio of 1, the K factor is 0.27. For a radius/thickness ratio of 4, the K factor is 0.5. 
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• Make the modifications according to your needs. 

•  Save the unfolding rule document, close it, then  check it into the vault. 

Note: To be able to use the unfolding rule in your default unfoldings, you have to edit the unfolding template in 
your project template. By default, it is located in the Templates > Defaults folders of your project template. 

 

To assign the unfolding rule to an unfolding document, you simply have to proceed as follows. 

• Reference the library. To do this, right-click on the References folder and select the  Reference Library 
command. 

• Open the Unfolding document. 

•  Drag the unfolding rule from your library into the graphics area. 

You can make sure that the unfolding rule has been taken into account by editing the Part inclusion operation from 
the Operations tree (if a message is displayed, confirm it). The Unfolding rules redefinition icon in the dialog box 
and the option Predefined rules must be checked and the rule must be selected. 

 

•  Save the unfolding document, close it, then  check it into the vault. 
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Annex: Creating the Central Support For the Right Stair 

In this exercise, we will finish the design of the right stair previously created. The small section of the UPNs used to 
create the stringers require support in the center of the stair. This support should remain in the center regardless 
of the angle, backward movement or height of the stair. 

 

Creating the structure 

• Open or return to the Right stair assembly document. 

• Right-click on the front face of the first step and select the Others (in the Selection section) >  Midplane 
command. 

 
  



Annex: Creating the Central Support For the Right Stair  TopSolid’Steel - Basics 

188   TopSolid 

• Select the face as shown below of the up plate as the second plane. 

 

• Right-click on the previously created plane and select the  Sketch command. 

• Draw the sketch as shown below. 
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As you can see, the position of the support is complicated to dimension because it depends on the stringers and 
the position of the plane. 

 

• From the Construction tab, select the  Intersection Point command still from the sketch context. 

• Select the sketch plane as the first geometry and the low outer edge of the stringer as the second geometry. 

 

• Complete the sketch by adding the dimension as shown below. 

 

• Confirm the sketch. 
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• On one of the vertical lines, position a  full circular section NF A 45-003 with the 20 code. 

 

• On the horizontal segment below, add a first  full flat section NF A 45-005 with the 100 x 10 code and a 
vertical shift of -20mm. 
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• Add the second  full flat section NF A 45-005 with the 100 x 10 code and a vertical shift of -20mm. To do 
this, select the line again, click once on the Reference direction arrow and check the Invert box. 

 

• Add a  full flat section NF A 45-005 with the 100 x 10 code in  Two points mode. 
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• Add a last  full flat section NF A 45-005 with the 80 x 10 code. 

 

Adding fixings 

• From the Modeling tab, select the  Drilling command. 

The goal is to drill the plate in line with the full circular section. To facilitate this operation, we will create a frame. 

• In the Frame field, click on the  icon and select the  Frame on Plane. 

• Select the face as shown below as the OXY plane and the axis of the full circular section as the intersection 
axis. 

 

• Click on  to confirm the frame. 

• Select the full flat 80 x 10 section as the parts to drill and enter a diameter of 22mm. 

 

• Click on  to confirm the drilling. 
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• Right-click on the circular extruded bar and select the  Planar Trim command. 

• Select the face as shown below and enter an offset of -40mm. 

 

• Double-click on the circular extruded bar to edit the part in place. 

TopSolid displays the extruded as it is inserted; the other extruded bars and the extension are not visible. 

• To correct this, click on the  End inserting icon in the document’s tab. 

 

Note: To edit this operation by default, you simply have to select the Tools > Options > Assembly command and 
check the Show posterior context when editing in-place part. This mode of operation is better suited to the 
metalwork and locksmith trades. 

• Right-click on the edge as shown below and select the  Chamfer command. 

• Enter a value of 2mm. 
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• From the Shape tab, select the  Threading command. 

• Select the face of the circular extruded bar as the face to thread, enter a length of 60mm and select the Metric 
ISO 724 standard. 

 

• Click on  to confirm the operation. 

• Confirm the in-place editing context. 

• At the top right of the screen, click on the  Quick Search icon. 

• Adjust the settings as shown below. 

 

• Click on the  icon to launch the search. TopSolid displays the search results. 

• Close the quick search dialog box. 
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• Add a hexagonal nut (style 2) ISO 4033. 

• Select the M20 code. 

 

• Position the nut. To do this, you simply have to bring the cursor near the drilling. TopSolid will automatically 
hook onto it. 

• Similarly, add a hexagon domed cap nut DIN 1587 with the M20 code. 

 

• From the Construction tab, select the  Repetition command. 

• Select the elements as shown below as the entities to be repeated. 
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• In the Pattern field, create a  symmetrical pattern. 

• Select the central plane of the stair (Plane 1 normally) as the plane. 

• Select Rotation as the transforms type. Select a point as shown below as the translations origin and select 
Absolute Z Axis as the rotations direction. 

 

• Click on  to confirm the pattern. 

• Click on  to confirm the repetition. 

• Create the following sketch on the central support plane. Use the  Centering constraint. 
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• Add a  hollow square section, ISO 4019 with the 40 x 4 code as shown below. 

 

• Perform a  planar trim operation by selecting the bottom of the stringer as the trimming plane. 

 

We will now add the fixings. 

• Draw the following sketch. 
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• Use the  quick search to find a hexagon screw ISO 4017. 

• Add and position the screw. To do this, create a  frame on plane using the top point of the sketch. 

• Select the Bolt in Hole wizard. Enable the  Dimensioning icon in the dialog box, enter a hole diameter of 
17mm, then select the flat as shown below as the last element to fix. 

 

TopSolid looks for the right dimension in the family to tighten the different parts and add a nut. 

• In the Use Process dialog box, select the Clearance Hole process, then select Coarse from the Clearance Hole 
Diameter Type drop-down menu. 
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• Add a flat washer - M, NF E 25-513 with the 16 code. 

 

• Add a hexagonal nut (style 2) ISO 4033 with code 16. 

 

• From the Construction tab, select the  Repetition command. 

• Select the screw, washer and nut. 
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• Create a  linear pattern in  Line by two points mode. 

• Select the two points of the sketch as shown below. 

 

• Click on  to confirm the pattern. 

• Click on  to confirm the repetition. 

• From the Construction tab, select the  Repetition command. 
• Select the small section as the entities and select the bolt as the repetition. 

 

• Create a  symmetrical pattern. Select the Plane mode and select the symmetry plane of the stair. Select 
Translation as the transforms type. Select one of the two points of the sketch as the translations origin. 
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Organizing the Operations tree 

• In the Operations tree, identify the first operation that corresponds to the creation of the central support (the 
second middle plane normally, after the inclusion of the right stringer). 

• Select all the operations above, right-click and select the  Folder command. 

 

• Rename the folder Central Support. 
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Error management 

We have seen previously that the sub-assemblies should be created at the end of the design as far as possible. In 
our case, the small added section belongs to the stringers; therefore, it must be in the stringers sub-assembly. 
Editing the operation will not be sufficient since the creation of the left and right stringer assemblies was done 
chronologically before the central support. 

• In the Operations tree, create a folder that contains the two inclusion operations for the right and left stringers. 

 

•  Drag this folder over the Central Support folder. 

 

TopSolid displays an error message and this  icon appeared on the document’s tab. This means that one or 
more operations are in error. The operation in error is displayed in red in the Operations tree. 

• Click on OK to close the error message. 

• Click on the  icon on the document's tab. TopSolid directly opens the operation in error and identifies the 
precise origin of the problem. In our case, we had used a plane of the right stringer sub-assembly except that it 
no longer exists at this stage. 

• Click in the Second plane field and select the plane as shown below again. 

 

• Click on  to confirm the operation. 

A new error message appears. 

• Click on OK to close the error message. 

• Click on the  icon on the document's tab. The intersection point was also based on the sub-assembly. 
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• Click in the Second geometry field and reconnect the edge of the stringer. 

 

• Click on  to confirm the operation. 

A new error message appears. 

• Click on OK to close the error message. 

• Click on the  icon on the document's tab. 

• Reconnect the trimming plane for the small section as shown below. 

 

The repair is now complete. 
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Editing the stringers 

• In the Operations tree, place the Modeling Stage cursor inside the Stringers folder. 

 

• Edit the left stringer inclusion operation and add the small section cut at an angle. 

 

• Repeat the procedure on the right-hand side. 
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• Create a new  In place assembly with all of the parts as shown below. 

 

• Click on the  End inserting icon to move the cursor to the top of the tree. 

•  Save the assembly document. 

What follows is a repetition of the previous exercises: 

- Bills of material with the names of the different parts/sub-assemblies 
- Detail draftings 
- Assembly draftings 
- etc. 
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Annex: Ramp Railing 

The objective of this exercise is to design a ramp railing on a concrete stair. 

 

Concepts addressed: 

- Using a constrained linear pattern to design a ramp railing 
- Converting a list to local parts 

Importing the concrete stair 

• From the Project tree, create a new folder named Ramp railing. 

In order to focus on the modeling of the railing, the stair has already been modeled. 

• Right-click on the Ramp railing folder and select the Import/Export >  Import Package command. Select the 
Parameterized Concrete Stair.TopPkg package. 

• Open the Parameterized Concrete Stair part document. 

Creating the railing 

• Right-click on the Ramp railing folder and select the  Assembly command. 

• Right-click on the new assembly document and select the  Properties command. 

• Click on the Edit button. In the Description field, enter Ramp railing and then click on  to confirm the 
operation. 

• At the top left of the screen, click on the  TopSolid 7 icon and select the File >  Background Document 
command. 

• Select the Parameterized Concrete Stair document. 
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• Draw the following sketch. 

 

• Confirm the sketch. 

• Right-click on the sketch and select the  Extruded bar command. 

• Select the Hollow square section, ISO 4019 family and the 40 x 2 code. 

• Select the entire sketch. 

• Position the extruded bars as shown below. 
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• Click on  to confirm the operation. 

• Right-click on one of the extruded bars and select the  Miter Trim command. 

• Select all the extruded bars and then click on  to confirm the operation. 

 

We will now create the sketch that will be used to trim the bars. 
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• Right-click on the according to extruded bars plane and select the  Sketch command. 

 

• Draw the following sketch (parallel to 40mm from the previous sketch + point). 
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• From the Construction tab, select the  Constrained Linear Pattern command. 

• Select the  Between points mode and adjust the dialog box as shown below. 

 

  

• Click on  to confirm the pattern. 
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• From the Modeling tab, select the  Extruded Bar command. 

• Select the Full Square Section, NF A 45-004 family and the 14 code. 

• Select the  Frame and Length mode. 

• In the Destination frame field, select the frame of the constrained linear pattern. 

 

• Enter a length of 1500mm to make sure that the section exceeds the border in all circumstances. 

• Add a vertical shift of 20mm to center the bar on the hollow square sections as shown below. 

 

• Click on  to confirm the extruded bar. 
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• From the Construction tab, select the  Repetition command. 

• Select the extruded bar previously included as the entities to be repeated. 

• Click in the Pattern field to enable it. Select a point of the constrained linear repetition as shown below. 

 

• Click on  to confirm the repetition. 

• Right-click on second sketch (the one with the 40mm parallel) and select the  Trim by Profile command. 

• In the Part to modify field, select the repetition of the bars, then click on  to confirm the operation. 

 

TopSolid converts all of the parts into local parts. This means that these parts do not have a document in the Project 
tree. Their management is done entirely from the assembly stage. 

• Open the Parameterized Concrete Stair part document. 

• From the Entities tree, open the Parameters folder, then work on the Tread, UnitRise and StepNumber 
parameters to test the railing.  
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 USE OF ACQUIRED KNOWLEDGE IN THIS TRAINING  No Somewhat no Somewhat yes Yes 
Have you found this training to be useful in your work? □ □ □ □ 
Do you think you can put the acquired knowledge into use quickly? □ □ □ □ 
Do you believe that you have achieved your objectives  

upon completion of this course? □ □ □ □ 
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